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User’s Guide
Basic

imagine the possibilities
This guide provides information concerning installation, basic operation and troubleshooting on
windows.
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1. Introduction
This chapter provides information you need to know before using the
machine.

• Key benefits

5

• Features by models
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• Useful to know
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• About this user’s guide
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• Reinstalling the driver
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Key benefits
Environmentally friendly

- For duplex printing, 15 ppm (A4) or 16 ppm (Letter).
ML-371xD/ ML-371xND/ ML-371xDW:
- For single-side printing, 35 ppm (A4) or 37 ppm (Letter).
- For duplex printing, 17 ppm (A4) or 18 ppm (Letter).

Convenience
• To save toner and paper, this machine supports Eco feature.
• To save paper, you can print multiple pages on one single sheet of
paper (see Advanced Guide).
• To save paper, you can print on both sides of the paper (doublesided printing) (see Advanced Guide).
• To save electricity, this machine automatically conserves electricity
by substantially reducing power consumption when not in use.

Print with excellent quality and speed



• You can print with a resolution of up to 1,200 x 1,200 dpi effective
output.
• Fast, on-demand printing.
ML-330x:
- For single-side printing, 31 ppm (A4) or 33 ppm (Letter).
ML-331xD/ ML-331xND:
- For single-side printing, 31 ppm (A4) or 33 ppm (Letter).

• Samsung Easy Printer Manager and Samsung Printer Status (or Smart
Panel) are a program that monitors and informs you of the machine’s
status and allows you to customize the machine’s settings (see
Advanced Guide).
• AnyWeb Print helpsyou screen-capture, preview, scrap, and print
the screen of Windows Internet Explorer more easily, than when you
use the ordinary program (see Advanced Guide).

Key benefits
Wide range of functionality and application support

• Supports various paper sizes (see "Print media specifications" on page 85).
• Print watermark: You can customize your documents with words, such as “Confidential” (see Advanced Guide).
• Print posters: The text and pictures of each page of your document are magnified and printed across the multiple sheets of paper and can then
be taped together to form a poster (see Advanced Guide).
• You can print in various operating systems (see "System requirements" on page 88).
• Your machine is equipped with a USB interface and/or a network interface.

Expand your machine’s capacity
 page 52).
• This machine has an extra memory slot for adding more memory (see "Available accessories" on
• ML-371xD/ ML-371xND/ ML-371xDW: Emulation compatible with PostScript 3 (PS3) enables PS printing.



Features by models
Some features and optional goods may not be available depending on model or country.
Features

ML-331xD

ML-331xND

ML-371xD

ML-371xND

ML-371xDW

Hi-Speed USB 2.0

●

●

●

●

●

IEEE 1284 parallel connector

○

○

○

○

○

●

●

●

Network Interface Ethernet 10/100 Base TX
wired LAN
Network Interface Ethernet 10/100/1000 Base
TX wired LAN

●

Network Interface 802.11b/g/n wireless LAN
●

IPv6
Eco printing

●

●

Wi-Fi Protected Setup™ (WPS)
Duplex (2-sided) printing

Samsung Easy Printer Manager

●

●


●

●
●

●

●

●

●

●

●

●

●

●

●

○

○

○

○

○

○

●

●

Memory
Tray 2 (520 sheets)

○

SyncThru™ Web Service

●

( ●: Included, ○: Optional, Blank: Not available)

●

Useful to know
The machine does not print.

A paper jam has occurred.

• Open the print queue list and remove the document from
the list (see "Canceling a print job" on page 44).

• Open and close the front door.

• Remove the driver and install it again (see "Installing the
driver locally" on page 23).
• Select your machine as your default machine in your
Windows.

• Check the instructions on removing jammed paper in this
manual and troubleshoot accordingly (see "Clearing
paper jams" on page 68).

Printouts are blurry.

Where can I purchase accessories or supplies?

• The toner level might be low or uneven. Shake the toner
cartridge.

• Inquire at a Samsung distributor or your retailer.

• Try a different print resolution setting.

• Visit www.samsung.com/supplies. Select your country/
region to view product service information.

• Replace the toner cartridge.

Where can I download the machine’s driver?
The status LED flashes or remains constantly on.
• Turn the product off and on again.
• Check the meanings of LED indications in this manual
and troubleshoot accordingly (see "Understanding the
status LED" on page 74).

• Visit www.samsung.com/printer to download the latest
machine’s driver, and install it on your system.

About this user’s guide
This user's guide provides information for your basic understanding
of the machine as well as detailed steps to explain machine usage.
•

Read the safety information before using the machine.

•

If you have a problem using the machine, refer to the
troubleshooting chapter.

•

Terms used in this user’s guide are explained in the glossary
chapter.

•

All illustrations in this user’s guide may differ from your machine
depending on its options or model you purchased.

•

The screenshots in this user's guide may differ from your machine
depending on the machine’s firmware/driver version.

•

The procedures in this user’s guide are mainly based on Windows
7.

1



 Conventions

Some terms in this guide are used interchangeably, as below:
•

Document is synonymous with original.

•

Paper is synonymous with media, or print media.

•

Machine refers to printer or MFP.

1. Introduction
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 General icons

Icon

Text

Description

Caution

Gives users information to protect the
machine from possible mechanical damage
or malfunction.

Note

Provides additional information or detailed
specification of the machine function and
feature.

9

Safety information
These warnings and precautions are included to prevent injury to
you and others, and to prevent any potential damage to your
machine. Be sure to read and understand all of these instructions
before using the machine. After reading this section, keep it in a safe
place for future reference.

1. Introduction
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 Operating environment
Warning

3



 Important safety symbols

Do not use if the power cord is damaged or if the
electrical outlet is not grounded.
This could result in electric shock or fire.

Explanation of all icons and signs used in this chapter

Warning
Caution

Hazards or unsafe practices that may result in
severe personal injury or death.
Hazards or unsafe practices that may result in
minor personal injury or property damage.

Do not attempt.

Do not place anything on top of the machine (water,
small metal or heavy objects, candles, lit cigarettes, etc.).
This could result in electric shock or fire.
• If the machine gets overheated, it releases smoke,
makes strange noises, or generates an odd odor,
immediately turn off the power switch and unplug the
machine.
• The user should be able to access the power outlet in
case of emergencies that might require the user to pull
the plug out.
This could result in electric shock or fire.
Do not bend, or place heavy objects on the power cord.
Stepping on or allowing the power cord to be crushed by
a heavy object could result in electric shock or fire.

Safety information

1. Introduction
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Do not remove the plug by pulling on the cord; do not
handle the plug with wet hands.

Do not allow pets to chew on the AC power, telephone
or PC interface cords.

This could result in electric shock or fire.

This could result in electric shock or fire and/or injury to
your pet.
If the machine does not operate properly after these
instructions have been followed, unplug the machine
from all interface connections and request assistance
from qualified service personnel.

Caution
During an electrical storm or for a period of nonoperation, remove the power plug from the electrical
outlet.
This could result in electric shock or fire.
Be careful, the paper output area is hot.

Otherwise, this could result in electric shock or fire.
5



 Operating method

Burns could occur.
If the machine has been dropped, or if the cabinet
appears damaged, unplug the machine from all
interface connections and request assistance from
qualified service personnel.
Otherwise, this could result in electric shock or fire.
If the plug does not easily enter the electrical outlet, do
not attempt to force it in.
Call an electrician to change the electrical outlet, or this
could result in electric shock.

Caution
Do not forcefully pull the paper out during printing.
It can cause damage to the machine.
Be careful not to put your hand between the machine
and paper tray.
You may get injured.

Safety information

1. Introduction
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6

Do not block or push objects into the ventilation
opening.
This could result in elevated component temperatures
which can cause damage or fire.



 Installation / Moving
Warning

Be care when replacing paper or removing jammed
paper.
New paper has sharp edges and can cause painful cuts.
When printing large quantities, the bottom part of the
paper output area may get hot. Do not allow children to
touch.
Burns can occur.
When removing jammed paper, do not use tweezers or
sharp metal objects.
It can damage the machine.
Do not allow too many papers to stack up in the paper
output tray.
It can damage the machine.

Do not place the machine in an area with dust, humidity,
or water leaks.
This could result in electric shock or fire.

Caution
Before moving the machine, turn the power off and
disconnect all cords.
Then lift the machine:
• If the machine weighs under 20 kg (44.09 lbs), lift with
1 person.

This machine's power reception device is the power cord.

• If the machine weighs 20 kg (44.09 lbs) - 40kg (88.18
lbs), lift with 2 people.

To switch off the power supply, remove the power cord
from the electrical outlet.

• If the machine weighs more than 40 kg (88.18 lbs), lift
with 4 or more people.
The machine could fall, causing injury or machine
damage.

Safety information

1. Introduction

Do not place the machine on an unstable surface.

Use the power cord supplied with your machine for safe
operation. If you are using a cord which is longer than 2
meters (6 feet) with a 110 V machine, then the gauge
should be 16 AWG or larger.

The machine could fall, causing injury or machine
damage.
The machine should be connected to

Otherwise, it can cause damage to the machine, and
could result in electric shock or fire.

the power level which is specified on the label.
If you are unsure and want to check the power level you
are using, contact the electrical utility company.
Use only No.26 AWGa or larger, telephone line cord, if
necessary.

13

a. AWG: American Wire Gauge
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 Maintenance / Checking

Otherwise, it can cause damage to the machine.
Do not put a cover over the machine or place it in an
airtight location, such as a closet.
If the machine is not well-ventilated, this could result in
fire.
Make sure you plug the power cord into a grounded
electrical outlet.
Otherwise, this could result in electric shock or fire.
Do not overload wall outlets and extension cords.
This can diminish performance, and could result in
electric shock or fire.

Caution
Unplug this product from the wall outlet before
cleaning the inside of the machine. Do not clean the
machine with benzene, paint thinner or alcohol; do not
spray water directly into the machine.
This could result in electric shock or fire.
When you are working inside the machine replacing
supplies or cleaning the inside, do not operate the
machine.
You could get injured.

Safety information

1. Introduction
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8

Keep the power cable and the contact surface of the
plug clean from dust or water.



 Supply usage

Otherwise, this could result in electric shock or fire.
• Do not remove any covers or guards that are
fastened with screws.
• Fuser units should only be repaired by a certified
service technician. Repair by non-certified
technicians could result in fire or electric shock.
The machine should only be repaired by a Samsung
service technician.
Keep cleaning supplies away from children.
Children could get hurt.
Do not disassemble, repair or rebuild the machine by
yourself.
It can damage the machine. Call a certified technician
when the machine needs repairing.
To clean and operate the machine, strictly follow the
user's guide provided with the machine.
Otherwise, you could damage the machine.

Caution
Do not disassemble the toner cartridge.
Toner dust can be dangerous if inhaled or ingested.
Do not burn any of the supplies such as toner cartridge
or fuser unit.
This could cause an explosion or uncontrollable fire.
When changing the toner cartridge or removing
jammed paper, be careful not to let toner dust touch
your body or clothes.
Toner dust can be dangerous if inhaled or ingested.
When storing supplies such as toner cartridges, keep
them away from children.
Toner dust can be dangerous if inhaled or ingested.
Using recycled supplies, such as toner, can cause
damage to the machine.
In case of damage due to the use of recycled supplies, a
service fee will be charged.

Safety information
When toner gets on your clothing, do not use hot water
to wash it.
Hot water sets toner into fabric. Use cold water.

1. Introduction
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Machine overview

1. Introduction
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 Accessories

Power cord

Quick installation guide

Software CDa

Misc. accessoriesb

a. The software CD contains the printer driver and applications.
b. Miscellaneous accessories included with your machine may vary by country of purchase and specific
model.

16

Machine overview
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 Front view
• This illustration may differ from your machine depending on its model.
• Some features and optional goods may not be available depending on model or country.

1

9

2
10

8
3
7
4

11

6

5

1 Output tray

4 Front cover

7

Tray 1

10

Paper width guides on a multi-purpose tray

2 Control panel

5 Paper level indicator

8

Multi-purpose tray

11

Output support

3

6

9

Multi-purpose tray paper
extension

Control board cover

Tray 2

17

Machine overview

1. Introduction
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 Rear view
• This illustration may differ from your machine depending on its model.
• Some features and optional goods may not be available depending on model or country.

1
2
3

8
4
5
6

7

1 Network port

3 IEEE 1284 parallel connector

5

Power receptacle

7

Rear cover

2 USB port

4 Power-switch

6

Duplex unit

8

Tray back cover
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Control panel overview
This control panel may differ from your machine depending
on its model. There are various types of control panels.

1. Introduction

Stops an operation at any time and there are
more functions.

2

• Cancels the current job.
(Cancel)

12



 Type A

3
(Power)

2

4

4

(Status
LED)

3

5
(Jam LED)

5

1
Eco

• Prints demo page: Press and hold this
button for about 5 seconds until the status
LED blinks, and release.
• Prints configuration reports: Press and
hold this button for about 3 seconds until
the status LED blinks, and release.

1

Enters eco mode to reduce toner
consumption and paper usage (see "Eco
options" on page 47).

19

You can turn the power on and off with this
button.
Shows the status of your machine (see
"Status LED" on page 75).
Shows the jam occurrance status of your
machine (see "Clearing paper jams" on page
68).

Control panel overview

1. Introduction
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 Type B

(Back)

5

Enters eco mode to reduce toner
consumption and paper usage (see
"Eco options" on page 47).

Eco

1

9

2

6

3

7

5

(Cancel)
(Power)

4
8

(Status
LED)

6

9
Arrows

7
8

1

Display

2
3

(Menu)

OK

Shows the current status and
prompts during an operation.
Enters menu mode and scrolls
through the available menus.
Confirms the selection on the
display.

Sends you back to the upper menu
level.

Stops an operation at any time.
You can turn the power on and off
with this button.
Shows the status of your machine
(see "Status LED" on page 75).
Navigates available values by
moving to the next or previous
options.

20

Control panel overview
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Enters eco mode to reduce toner
consumption and paper usage (see
"Eco options" on page 47).

5

 Type C

Eco
6

1
2
3
10

4

9

5

(Cancel)

7
(Power)
8

(Status
LED)

9

6

(WPS)

Stops an operation at any time.
You can turn the power on and off with
this button.
Shows the status of your machine (see
"Status LED" on page 75).
If your wireless access point supports
Wi-Fi Protected Setup™(WPS), you can
configure the machine easily without a
computer (see Advanced Guide).

7
8

1

Display

2
3
4

(Menu)
OK

Shows the current status and prompts
during an operation.
Enters menu mode and scrolls through
the available menus.
Confirms the selection on the display.

(Back)

Sends you back to the upper menu
level.

10

Arrows

Navigates available values by moving
to the next or previous options.

Turning on the machine
1

Connect the machine to the electricity supply first.

2

Press the

Turn the switch on if the machine has a power switch.

(Power) button, then release.

1. Introduction
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Installing the driver locally
A locally connected machine is a machine directly attached to your
computer using the cable. If your machine is attached to a network,
skip the following steps below and go on to installing a network
connected machine’s driver (see Advanced Guide).

1. Introduction

23

The software CD should automatically run and an installation
window will appear.

3

Select Install Now.

4

Read License Agreement, and select I accept the terms of
the License Agreement. Then, click Next.

5

Follow the instructions in the installation window.

• If you are a Macintosh, Linux, or Unix OS user, refer to the
Advanced guide.
• The installation window in this User’s Guide may differ
depending on the machine and interface in use.
• Selecting Advanced Installation > Custom Installation
allows you to choose which programs to install.
• Only use a USB cable no longer than 3 meters (118 inches ).

15



1

 Windows
Make sure that the machine is connected to your computer
and powered on.

If the “Found New Hardware Wizard” appears during the
installation procedure, click Cancel to close the window.

2

Insert the supplied software CD into your CD-ROM drive.

Reinstalling the driver
If the printer driver does not work properly, follow the steps below to
reinstall the driver.
16



 Windows

1

Make sure that the machine is connected to your computer
and powered on.

2

From the Start menu, select Programs or All Programs >
Samsung Printers > your printer driver name > Uninstall.

3
4

Follow the instructions in the installation window.
Insert the software CD into your CD-ROM drive and install the
driver again (see "Installing the driver locally" on page 23).

1. Introduction
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2. Menu overview and basic
setup
After installation is complete, you may want to set the machine’s default
settings. Refer to the next section if you would like to set or change values.
This chapter provides information about the overall menu structure and
the basic setup options.

• Menu overview

2

• Printing a demo page

4

• Changing the display language

5

• Media and tray

6

• Basic printing

17

Menu overview
The control panel provides access to various menus to set up the
machine or use the machine’s functions.

2. Menu overview and basic setup

Items

Options
Menu Map
Configuration

• These menus can be accessed by pressing
(Menu)
button. Press the arrows until the needed menu item
appears and press OK.
• An asterisk (*) appears next to the currently selected
menu.

Supplies Info.
Demo Page
Information

PCL Font
PS Font

• Some menus may not appear on the display depending on
options or models. If so, it is not applicable to your
machine.

EPSON Font
Usage Counter

• For models that do not have the display screen on the
control panel, this feature is not applicable.

Account Report
Orientation

• Some menu names may differ from your machine
depending on its options or the models.

Common Margin
Layout

MP Tray
Tray X
Emulation Mar.
Duplex Margin
Copies

Paper

MP Tray/ [Tray <x>]
Paper Source
Tray Chaining

28

Menu overview
Items
Graphic

Options

Items
TCP/IP (IPv4)

Darken Text

TCP/IP (IPv6)

Language

Ethernet Speed

Power Save

802.1x
Network

Wireless

Altitude Adj.

Clear Setting

Auto CR

Network Conf.

Job Timeout

Net. Activate

Maintenance

Http Activate

Toner Save

Customa

Eco Setup
Clear Setting
Emulation

Options

Resolution

Wakeup Event

System Setup

2. Menu overview and basic setup

Emulation Type
Setup

Active Job
Job
Management

Stored Job
File Policy

a. You can start applications. You need to register the application from the
SyncThru™ Web Service before you start the application.

29

Printing a demo page
Print a demo page to make sure that the machine is operating
correctly.

1
2
3

Press

(Menu) button on the control panel.

Press Information > OK > Demo Page > OK.
Press Print? > Yes > OK.
A demo page prints out.

If your machine does not have a display screen, press and
hold

(Cancel) button for about 5 seconds until the status

LED blinks, and release.

2. Menu overview and basic setup
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Changing the display language
To change the language that is displayed on the control panel,
follow these steps:

For models that do not have the display screen on the
control panel, this feature is not applicable.

1
2
3

Press

(Menu) button on the control panel.

Press System Setup > OK > Language > OK.
Press OK to select the language you want.

2. Menu overview and basic setup
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Media and tray
This chapter provides information on how to load print media into
your machine.

2. Menu overview and basic setup

2

1

• Using print media that does not meet these specifications
may cause problems or require repairs. Such repairs are
not covered by Samsung’s warranty or service
agreements.
• Make sure not to use the inkjet photo paper with this
machine. It could cause damage to the machine.

1 Paper length guide
2 Paper width guide

The duplex unit is preset to Letter/LGL or A4 size, depending on your
country. To change the paper size, adjust the guide as shown below.

• Using inflammable print media can cause a fire.
• Use designated print media (see "Print media
specifications" on page 4).

If you do not adjust the guide, it may cause paper
registration, image skew, or jamming of the paper.

The use of inflammable media or foreign materials left in the
printer may lead to overheating of the unit and, in rare cases
may cause a fire.

1
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 Tray overview

To change the size, you need to adjust the paper guides.
4

A

Media and tray

2. Menu overview and basic setup
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2

Paper quantity indicator shows the amount of paper in the
tray.

1

1 Full
2 Empty

2



 Loading paper in the tray/ optional tray

1
2

Pull out the paper tray.

3

Place paper with the side you want to print on facing down.

Flex or fan the edge of the paper stack to separate the pages
before loading papers.

Media and tray
4

2. Menu overview and basic setup

Slide the paper length guide until it lightly touches the end of
the paper stack.

34

• Do not push the paper width guide too far causing the
media to warp.
• If you do not adjust the paper width guide, it may cause
paper jams.

• Do not use a paper with a leading-edge curl, it may cause
a paper jam or the paper can be wrinkled.

5

Squeeze the paper width guide and slide it to the edge of the
paper stack without causing it to bend.

6
7

Insert the tray back into the machine.
Set the paper type and size for tray 1 (see "Setting the paper
size and type" on page 16).

Media and tray
The settings set from the machine driver override the
settings on the control panel.
a To print from an application, open an application and start
the print menu.
b Open Printing Preferences (see "Opening printing
preferences" on page 19).
c Press the Paper tab in Printing Preferences, and select an
appropriate paper type.

3



 Loading in multi-purpose tray

The multi-purpose tray can hold special sizes and types of print
material, such as postcards, note cards, and envelopes.
•

The machine does not have a display screen: 1 sheet of 80 g/
m2 (20 lbs bond)

•

The machine has the display screen: 50 sheets of 80 g/m2 (20
lbs bond)

2. Menu overview and basic setup
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Tips on using the multi-purpose tray
• To prevent paper jams, do not add paper while printing
when there is still paper in the multi-purpose tray.
• Print media should be loaded face up with the top edge
going into the multi-purpose tray first and be placed in the
center of the tray.
• To ensure printing quality and to prevent paper jams, only
load the available paper (see "Print media specifications"
on page 4).
• Flatten any curl on postcards, envelopes, and labels before
loading them into the multi-purpose tray.
• When printing on special media, you must follow the
loading guidelines (see "Printing on special media" on
page 11).
• When papers overlap when printing using the multipurpose tray, open tray 1 and remove the overlapping
papers then try printing again.
• When paper does not feed well while printing, push the
paper in manually until it starts feeding automatically.

Media and tray
1

Open the multi-purpose tray and unfold the multi-purpose
tray extension, as shown.

2. Menu overview and basic setup
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3

Flex or fan the edge of the paper stack to separate the pages
before loading paper.

4

Load the paper. Squeeze the multi-purpose tray paper width
guides and adjust them to the width of the paper.

5

Set the paper type and size from the control panel (see
"Setting the paper size and type" on page 16).

2

1

2

Adjust the multi-purpose tray paper width guides to the width
of the paper.

Media and tray

2. Menu overview and basic setup
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• When using special media, we recommend you feed one
sheet at a time (see "Print media specifications" on page 4).

The settings set from the machine’s driver override the
settings on the control panel.
a To print from an application, open an application and start
the print menu.
b Open Printing Preferences (see "Opening printing
preferences" on page 19).
c Press the Paper tab in Printing Preferences and select an
appropriate paper type.
For example, if you want to use a label, set the paper type
to Label.
d Select MP Tray in paper source, then press OK.
e Start printing in application.

• Printing the special media (Face up)
If special media are printed out with curl, wrinkles, crease,
or black bold lines, open the rear cover and pull down the
pressure lever as shown below and try printing again.
Keep the rear cover opened during printing.

4



 Printing on special media

The table below shows the special media usable in each tray.
The media types are shown in the Printing Preferences. Select the
proper media type to get the highest printing quality.

To see for paper weights for each sheet, refer to "Print media
specifications" on page 4.

Tray 1

Optional
tray

Multi-purpose tray

Plain

?

?

?

Thick

?

?

?

Types

Media and tray
Types

Tray 1

2. Menu overview and basic setup

Optional
tray

Thicker

To print an envelope, place it as shown in the following figure.
Multi-purpose tray
?

Thin

?

?

?

Bond

?

?

?

Color
CardStock

38

?
?

?

?

Labels

?

Transparency

?

Envelope

?

Preprinted

?

Cotton

?

Recycled

?

?

?

Archive

?

?

?

( ?: Included, Blank: Not available)

Envelope
Printing successfully on envelopes depends upon the quality of the
envelopes.

If envelopes are printed out with wrinkles, crease, or black bold lines,
open the rear cover and pull down the pressure lever on the right
side about 90 degrees and try printing again. Keep the rear cover
opened during printing.

Media and tray

2. Menu overview and basic setup
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Be sure the seam at both ends of the envelope extends all the
way to the corner of the envelope.
2

1

1 Acceptable
2 Unacceptable
1

•

1 Pressure lever

•

Envelopes with a peel-off adhesive strip or with more than one
flap that folds over to seal must use adhesives compatible with
the machine’s fusing temperature for 0.1 second (about 170°C
(338 °F)). The extra flaps and strips might cause wrinkling,
creasing, or jams, and may even damage the fuser.

When selecting envelopes, consider the following factors:
-

Weight: should not exceed 90 g/m2 otherwise; jams may
occur.

-

Construction: should lie flat with less than 6 mm curl and
should not contain air.

•

For the best print quality, position margins no closer than 15 mm
from the edges of the envelope.

-

Condition: should not be wrinkled, nicked, nor damaged.

•

Avoid printing over the area where the envelope’s seams meet.

-

Temperature: should resist the heat and pressure of the
machine during operation.

•

Use only well-constructed envelopes with sharp and wellcreased folds.

•

Do not use stamped envelopes.

•

Do not use envelopes with clasps, snaps, windows, coated lining,
self-adhesive seals, or other synthetic materials.

•

Do not use damaged or poorly made envelopes.

Media and tray
Transparency
To avoid damaging the machine, use only transparencies designed
for use in laser printers.

2. Menu overview and basic setup
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•

Do not use transparencies that separate from the backing sheet.

•

To prevent transparencies from sticking to each other, do not let
the printed sheets stack up as they are being printed out.

•

Recommended media: Transparency for a color laser printer by
Xerox, such as 3R 91331(A4), 3R 2780 (Letter)

Labels
To avoid damaging the machine, use only labels designed for use in
laser printers.

•

Must withstand the machine’s fusing temperature.

•

Place them on a flat surface after removing them from the
machine.

•

Do not leave unused transparencies in the paper tray for long.
Dust and dirt may accumulate on them, resulting in spotty
printing.

•

To avoid smudging caused by fingerprints, handle them
carefully.

•

To avoid fading, do not expose printed transparencies to
prolonged sunlight.

•

Ensure that transparencies are not wrinkled, curled, or have any
torn edges.

•

When selecting labels, consider the following factors:
-

Adhesives: Should be stable at your machine’s fusing
temperature. Check your machine’s specifications to view the
fusing temperature (about 170°C (338°F)).

Media and tray
-

Arrangement: Only use labels with no exposed backing
between them. Labels can peel off sheets that have spaces
between the labels, causing serious jams.

-

Curl: Must lie flat with no more than 13 mm of curl in any
direction.

-

Condition: Do not use labels with wrinkles, bubbles, or other
indications of separation.

•

Make sure that there is no exposed adhesive material between
labels. Exposed areas can cause labels to peel off during printing,
which can cause paper jams. Exposed adhesive can also cause
damage to machine components.

•

Do not run a sheet of labels through the machine more than
once. The adhesive backing is designed for only a single pass
through the machine.

•

Do not use labels that are separating from the backing sheet or
are wrinkled, bubbled, or otherwise damaged.
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Card stock/ Custom-sized paper

•

In the software application, set margins at least 6.4 mm (0.25
inches) away from the edges of the material.
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Media and tray
Preprinted paper
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When loading preprinted paper, the printed side should be facing up
with an uncurled edge at the front. If you experience problems with
paper feeding, turn the paper around. Note that print quality is not
guaranteed.
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 Setting the paper size and type

After loading paper in the paper tray, set the paper size and type
using the control panel buttons.
• The settings set from the machine’s driver override the
settings on the control panel.
• For models that do not have the display screen on the
control panel, this feature is not applicable.

•

•
•

Must be printed with heat-resistant ink that will not melt,
vaporize, or release hazardous emissions when subjected to the
machine’s fusing temperature for 0.1 second (about 170°C
(338°F)).
Must be non-flammable and should not adversely affect machine
rollers.
Before you load preprinted paper, verify that the ink on the paper
is dry. During the fusing process, wet ink can come off preprinted
paper, reducing print quality.

1
2
3
4
5

Press

(Menu) button on the control panel.

Press Paper > OK > Select the tray you want > OK.
Press Paper Size > OK > Select the option you want > OK.
Press Paper Type > OK > Select the option you want > OK
Press

(Cancel) to return to ready mode.

If you want to use special-sized paper such as billing paper,
select Custom in the Paper tab in the Printing Preferences
(see "Opening printing preferences" on page 19).

Basic printing
6



 Printing
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1
2
3

Open the document you want to print.
Select Print from the File menu.
Select your machine from the Select Printer list.

The basic print settings including the number of copies and
print range are selected within the Print window.

To take advantage of the advanced printing features, click
Properties or Preferences from the Print window (see
"Opening printing preferences" on page 19).

If you are a Macintosh, Linux, or Unix OS user, refer to the
Advanced Guide.

The following Printing Preferences window is for Notepad in
Windows 7.
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5

To start the print job, click OK or Print in the Print window.

Basic printing
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 Canceling a print job

If the print job is waiting in the print queue or print spooler, cancel
the job as follows:
•

You can access this window by simply double-clicking the
machine icon (

•

) in the Windows task bar.

You can also cancel the current job by pressing
the control panel.

(Cancel) on

44

Basic printing
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 Opening printing preferences
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Click Properties or Preferences.

• The Printing Preferences window that appears in this
user’s guide may differ depending on the machine in use.
• When you select an option in Printing Preferences, you
may see a warning mark or . An mark means you
can select that certain option but it is not recommended,
and an mark means you cannot select that option due
to the machine’s setting or environment.

1
2
3

Open the document you want to print.
Select Print from the file menu.

You can check the machine's current status using the Printer
Status button (see Advanced Guide).

Select your machine from the Select Printer.

Using a favorite setting
The Presets option, which is visible on each preferences tab except
for the Samsung tab, allows you to save the current preferences for
future use.
To save a Presets item, follow these steps:

Basic printing
1
2

Change the settings as needed on each tab.

2. Menu overview and basic setup
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 Using help

Enter a name for the item in the Presets input box.
Click the option you want to know on the Printing Preferences
window and press F1 on your keyboard.
10



3

Click
(Add). When you save Presets, all current driver
settings are saved.

Select more options and click
(Update), settings will be
added to the Presets you made. To use a saved setting, select
it from the Presets drop-down list. The machine is now set to
print according to the settings you have selected. To delete
saved settings, select it from the Presets drop-down list and
click

(Delete).

You can also restore the printer driver’s default settings by
selecting Default Preset from the Presets drop-down list.

 Eco printing

The Eco function cuts toner consumption and paper usage. The Eco
function allows you to save print resources and lead you to ecofriendly printing.
If you press the Eco button from the control panel, eco mode is
enabled. The default setting of eco mode is duplex (long edge), 2-up,
skip blank pages, and toner save.

Setting eco mode on the control panel
• The settings set from the machine’s driver override the
settings on the control panel.
• For models that do not have the display screen on the
control panel, this feature is not applicable.

Basic printing
1
2
3

Press

(Menu) button on the control panel.

Press System Setup > OK > Eco Setup > OK.
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Setting eco mode on the driver
Open the Eco tab to set eco mode. When you see the eco image
(
), that means the eco mode is currently enabled.

Press OK select the mode you want.
•

Default Mode: Select this to turn on or off the eco mode.
(Duplex (long edge)/Toner save/2-up/Skip blank pages)
-

Off: Set the eco mode off.

-

On: Set the eco mode on.

If you set the eco mode on with a password from the
SyncThru™ Web Service ( Settings tab > Machine Settings >
System > Eco > Settings), the Onforce message appears.
You have to enter the password to change the eco mode
status.

•

Change Temp.: Select the eco template.
-

Default Eco: The default setting of eco mode is duplex,
2-up, skip blank pages, and toner save.

-

Custom Eco: Follow the settings from Syncthru™ Web
Service. Before you select this item, you must set the
eco function in SyncThru™ Web Service> Settings tab
> Machine Settings > System > Eco > Settings.

► Eco options
•

Printer Default: Follows the settings from the machine's control
panel.

•

None: Disables eco mode.

•

Eco Printing: Enables eco mode. Activate the various eco items
you want to use.

•

Password: If the administrator fixed to enable the eco mode, you
have to enter the password to change the status.

Basic printing
► Result simulator
Result Simulator shows the results of reduced emission of carbon
dioxide, used electricity, and the amount of saved paper in
accordance with the settings you selected.
•

The results are calculated on the basis that the total number of
printed paper is one hundred without a blank page when the eco
mode is disabled.

•

Refer to the calculation coefficient about CO2, energy, and paper
from IEA, the index of Ministry of Internal Affairs and
Communication of Japan and www.remanufacturing.org.uk.
Each model has a different index.

•

The power consumption in printing mode refers to the average
printing power consumption of this machine.

•

The actual saved or reduced amount may differ depending on
the operating system used, computing performance, application
software, connection method, media type, media size, job
complexity, etc.

2. Menu overview and basic setup
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3. Maintenance
This chapter provides information about purchasing supplies, accessories
and maintenance parts available for your machine.

• Ordering supplies and accessories

50

• Available supplies

51

• Available accessories

52

• Available maintenance parts

53

• Redistributing toner

54

• Replacing the toner cartridge

56

• Upgrading a memory module

58

• Monitoring the supplies life

60

• Setting the toner low alert

61

• Cleaning the machine
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Ordering supplies and accessories

3. Maintenance
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Available accessories may differ from country to country. Contact your sales representatives to obtain the list of available supplies, and
maintenance parts.

To order Samsung-authorized supplies, accessories, and maintenance parts, contact your local Samsung dealer or the retailer where you
purchased your machine. You can also visit www.samsung.com/supplies, and then select your country/region to obtain the contact
information for service.

Available supplies

3. Maintenance

When supplies reach the end of their life spans, you can order the
following types of supplies for your machine:
Type

Average yielda

Part name

Standard yield
toner cartridge

Approx. 2,000 pages

MLT-D205S

High yield toner
cartridge

Approx. 5,000 pages

MLT-D205L

Extra high yield

Approx. 10,000 pages

MLT-D205E

toner cartridgeb
a. Declared yield value in accordance with ISO/IEC 19752.
b. The toner cartridge is available only for ML-371x Series and ML-3310ND/SIT.

Depending on the options and job mode used, the toner
cartridge’s lifespan may differ.

When purchasing new toner cartridges or other supplies,
these must be purchased in the same country as the machine
you are using. Otherwise, new toner cartridges or other
supplies will be incompatible with your machine due to
different configurations of toner cartridges and other
supplies according to the specific country conditions.
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Samsung does not recommend using non-genuine Samsung
toner cartridge such as refilled or remanufactured toner.
Samsung cannot guarantee non-genuine Samsung toner
cartridge's quality. Service or repair required as a result of
using non-genuine Samsung toner cartridges will not be
covered under the machine’s warranty.

Available accessories

3. Maintenance

You can purchase and install accessories to enhance your machine’s performance and capacity.

Some features and optional goods may not be available depending on models or countries (see "Features by models" on page 7).

Accessory
Memory module

Tray 2

Function
Extends your machine’s memory capacity.

• CLP-MEM201: 128 MB
• CLP-MEM202: 256 MB

If you are experiencing frequent paper supply problems, you can attach an
additional tray.

• ML-3310ND/ML-3710 Series: MLS3710A
• ML-3312ND/ML-3712 Series: MLS3712A

Allows you to use various interface.

IEEE 1284 parallel
connector

Part name

• When installing the printer driver with an IEEE1284 parallel
connector, the machine might not be found and after installing
the printer driver, only basic printing features are available.
• If you want to check the machine's status or set the settings,
connect the machine to a computer with a USB cable or a
network.
• If you use the IEEE 1284 parallel connector, you can not use the
USB cable.

ML-PAR100

52

Available maintenance parts
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To purchase maintenance parts, contact the source where you bought the machine. Replacing maintenance parts can be performed only by
an authorized service provider, dealer, or the retailer where you bought the machine. The warranty does not cover the replacement of any
maintenance parts once it has reached its “Average yield”.
Maintenance parts are replaced at specific intervals to avoid print quality and paper feed problems resulting from worn parts, see table below.
The purpose of which is to maintain your machine in top working condition. The maintenance parts below should be replaced when the life
span of each item has been met.
Average yielda

Parts
Transfer roller

Approx. 100,000 pages

Fuser unit

Approx. 90,000 pages

Pickup roller

Approx. 90,000 pages

Retard roller

Approx. 60,000 pages

a. It will be affected by the operating system used, computing performance, application software, connecting method, media
type, media size and job complexity.

Redistributing toner
When the toner cartridge is near the end of its life:
•

White streaks or light printing occurs and/or density variation
side to side.

•

The Status LED blinks red.

3. Maintenance
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Thoroughly roll the cartridge five or six times to distribute the
toner evenly inside the cartridge.

If this happens, you can temporarily improve print quality by
redistributing the remaining toner in the cartridge. In some cases,
white streaks or light printing will still occur even after you have
redistributed the toner.

1

Open the front cover and pull the toner cartridge out.

If toner gets on your clothing, wipe it off with a dry cloth and
wash clothing in cold water: hot water sets toner into fabric.

Do not touch the green underside of the toner cartridge. Use
the handle on the cartridge to avoid touching this area.

3

Redistributing toner
3

Hold the toner cartridge by the handle and slowly insert the
cartridge into the opening in the machine.

4

Close the front cover. Ensure that the cover is securely closed.

3. Maintenance

55

Replacing the toner cartridge
Click this link to open an animation about replacing a toner
cartridge.

3. Maintenance
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3

Remove the label from the toner cartridge as shown below.

4

Thoroughly shake side to side the cartridge five or six times to
distribute the toner evenly inside the cartridge.

When a toner cartridge has reached the end of life, the machine will
stop printing.

1

Open the front cover and pull the toner cartridge out.

3

If toner gets on your clothing, wipe it off with a dry cloth and
wash clothing in cold water: hot water sets toner into fabric.

2

Remove the new toner cartridge from its bag.
Do not touch the green underside of the toner cartridge. Use
the handle on the cartridge to avoid touching this area.

Replacing the toner cartridge
5

Hold the toner cartridge by the handle and slowly insert the
cartridge into the opening in the machine.

6

Close the front cover. Make sure that the cover is securely
closed.

3. Maintenance
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Upgrading a memory module
Your machine has a dual in-line memory module (DIMM). Use this
memory module slot to install additional memory.

3. Maintenance

4

Order information is provided for additional memory module. (See
"Available accessories" on page 52.)
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Holding the memory module by the edges, align the memory
module on the slot at about a 30-degree tilt. Make sure that
the notches of the module and the grooves on the slot fit each
other.

1

Installing a memory module

1
2

Turn the machine off and unplug all cables from the machine.
Grasp the control board cover and remove it.

The notches and grooves illustrated above may not match
those on an actual memory module and its slot.

5

3

Remove the new memory module from its bag.

Press the memory module into the slot with care until you
hear a ‘click’.

Do not press the memory module strongly or the module
may be damaged. If the module does not seem to fit into the
slot properly, carefully try the previous procedure again.

Upgrading a memory module
6
7

Replace the control board cover.
Reconnect the power cord and machine cable and turn the
machine on.

3. Maintenance
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Monitoring the supplies life
To view the supply life indicators, follow the steps below:

1
2
3
4

Press

(Menu) on the control panel.

Press System Setup > OK > Maintenance > OK.
Press Supplies Info > OK.
Press OK to select the option you want.

For models that do not support the display screen on the control panel, this feature is not applicable.

3. Maintenance
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Setting the toner low alert

3. Maintenance
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If the amount of toner in the cartridge is low, a message or LED informing the user to change the toner cartridge appears. You can set the
option for whether or not this message or LED appears.

1
2
3
4

Press

(Menu) on the control panel.

Press System Setup > OK > Maintenance > OK.
Press Toner Low Alert > OK.
Select the option you want, then press OK.

For models that do not support the display screen on the control panel, this feature is not applicable.

Cleaning the machine
If printing quality problems occur or if you use your machine in a
dusty enviroment, you need to clean your machine regularly to keep
it in the best printing condition and use your machine longer.

• Cleaning the cabinet of the machine with cleaning
materials containing large amounts of alcohol, solvents, or
other strong substances can discolor or distort the
cabinet.
• If your machine or the surrounding area is contaminated
with toner, we recommend you use a cloth or tissue
dampened with water to clean it. If you use a vacuum
cleaner, toner blows in the air and might be harmful to
you.

3. Maintenance
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Cleaning the inside
During the printing process, paper, toner, and dust particles can
accumulate inside the machine. This buildup can cause print quality
problems, such as toner specks or smearing. Cleaning the inside of
the machine clears and reduces these problems.

1

Turn the machine off and unplug the power cord. Wait for the
machine to cool down.

2

Open the front cover and pull the toner cartridge out. Set it on
a clean flat surface.

2

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the
cloth slightly with water, but be careful not to let any water drip onto
or into the machine.
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3

Cleaning the machine

3. Maintenance

• To prevent damage to the toner cartridge, do not expose
it to light for more than a few minutes. Cover it with a piece
of paper, if necessary.

While cleaning the inside of the machine, be careful not to
damage the transfer roller or any other inside parts. Do not
use solvents such as benzene or thinner. Printing quality
problems can occur and cause damage to the machine.

• Do not touch the green surface underside of the toner
cartridge. Use the handle on the cartridge to avoid
touching this area.

4
3

With a dry, lint-free cloth, wipe away any dust and spilled
toner from the toner cartridge area.
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Reinsert the toner cartridge and close the front cover.

Cleaning the machine
4

Cleaning the pickup roller

1

Turn the machine off and unplug the power cord. Wait for the
machine to cool down.

2

Pull out tray 1.

3. Maintenance
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Clean the pickup roller with a soft, lint-free cloth.

4

Insert the tray back into the machine.
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4. Troubleshooting
This chapter gives helpful information for what to do if you encounter an
error.

• Tips for avoiding paper jams

67

• Clearing paper jams

68

• Understanding the status LED

74

• Understanding display messages

77



This chapter gives helpful information for what to do if you
encounter an error.
If your machine has a display screen, check the message on the
display screen first to solve the error. If you cannot find a solution
to your problem in this chapter, refer to the Troubleshooting
chapter in the Advanced User's Guide.
If you cannot find a solution in the User's Guide or the problem
persists, call for service.

Tips for avoiding paper jams

4. Troubleshooting

By selecting the correct media types, most paper jams can be avoided. To avoid paper jams, refer to the following guidelines:
•

Ensure that the adjustable guides are positioned correctly (see "Tray overview" on page 32).

•

Do not overload the tray. Ensure that the paper level is below the paper capacity mark on the inside of the tray.

•

Do not remove paper from the tray while your machine is printing.

•

Flex, fan, and straighten paper before loading.

•

Do not use creased, damp, or highly curled paper.

•

Do not mix paper types in a tray.

•

Use only recommended print media (see "Print media specifications" on page 85).
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Clearing paper jams
To avoid tearing the paper, pull the jammed paper out slowly
and gently.

4. Troubleshooting

1

If the paper does not exit, go to the next step.

2

1

In tray 1

Click this link to open an animation about clearing a jam.

Open and close the front cover. The jammed paper is
automatically ejected from the machine.

Pull out tray 1 .
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Clearing paper jams
3

Remove the jammed paper by gently pulling it straight out.
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2

In optional tray2

Click this link to open an animation about clearing a jam.

1
2

Pull out optional tray 2.
Remove the jammed paper from the machine.

If the paper does not move when you pull, or if you do not see
the paper in this area, check the fuser area around the toner
cartridge (see "Inside the machine" on page 70).

4

Insert tray 1 back into the machine until it snaps into place.
Printing automatically resumes.

If the paper does not move when you pull or if you do not see
the paper in this area, stop and go to the next step.

Clearing paper jams
3
4

4. Troubleshooting

Pull tray 1 half-way out.
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1

If the paper is not feeding properly, pull the paper out of the
machine.

2

Open and close the front cover to resume printing.

Pull the paper straight up and out.

4

5

Insert the trays back into the machine. Printing automatically
resumes.

Inside the machine

Click this link to open an animation about clearing a jam.

3

In the multi-purpose tray

Click this link to open an animation about clearing a jam.

The fuser area is hot. Take care when removing paper from
the machine.

Clearing paper jams
1

4. Troubleshooting

3

Open the front cover and pull the toner cartridge out.

Replace the toner cartridge and close the front cover. Printing
automatically resumes.

5

In the exit area
3

Click this link to open an animation about clearing a jam.

1
2

Open and close the front cover. The jammed paper is
automatically ejected from the machine.
If you do not see the jammed paper, go to the next step.

Remove the jammed paper by gently pulling it straight out.

2
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Gently pull the paper out of the output tray.

Clearing paper jams
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If you do not see the jammed paper or if there is any resistance
when you pull, stop and go to the next step.

3
4

Pull the duplex unit out of the machine.

2

Remove the jammed paper from the duplex unit.

Open the rear cover.
Remove the jammed paper as shown in the following figure.

2

1

1

3
3

5

1

Close the rear cover. Printing automatically resumes.

6

In the duplex unit area

Click this link to open an animation about clearing a jam.
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Clearing paper jams
If the paper does not come out with the duplex unit, remove
the paper from the bottom of the machine.

4. Troubleshooting

5

Remove the jammed paper as shown in the following figure.

2

1

1

3
3

If you still do not see the paper, go to the next step.

3

Insert the duplex unit into the machine.

4

Open the rear cover.

6
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Close the rear cover. Printing automatically resumes.

Understanding the status LED

4. Troubleshooting

The color of the LED indicates the machine's current status.
• Some LEDs may not be available depending on model or country.
• To resolve the error, look at the error message and its instructions from the troubleshooting part.
• You also can resolve the error with the guideline from the computers’s Samsung Printer Status or Smart Panel program window.
• If the problem persists, call a service representative.
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Understanding the status LED
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 Status LED
Status

Description

Off

The machine is off-line.
Blinking

Green
On

Blinking
(Status LED)

• When the backlight slowly blinks, the machine is receiving data from the computer.
• When the backlight blinks rapidly, the machine is printing data.
• The machine is on-line and can be used.
• A minor error has occurred and the machine is waiting for the error to be cleared. Check the display
message. When the problem is cleared, the machine resumes. For some models that does not
support the display screen on the control panel, this feature is not applicable.
• Small amount of toner is left in the cartridge. The estimated cartridge life of toner is close. Prepare
a new cartridge for replacement. You may temporarily increase the printing quality by
redistributing the toner (see "Redistributing toner" on page 54).
• A toner cartridge has almost reached its estimated cartridge lifea. It is recommended to replace the
toner cartridge (see "Replacing the toner cartridge" on page 56).

Red

• The cover is opened. Close the cover.
On

• There is no paper in the tray. Load paper in the tray.
• The machine has stopped due to a major error. Check the display message (see "Understanding
display messages" on page 77).
• A paper jam has occurred (see "Clearing paper jams" on page 68).

Understanding the status LED
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a. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/
IEC 19752. The number of pages may be affected by operating environment, printing interval, graphics, media type and media size. Some amount of toner may
remain in the cartridge even when red LED is on and the printer stops printing.
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 Jam LED/ WPS LED
Status
(Jam LED)
(WPS LED)

Description

Orange

On

A paper jam has occurred (see "Clearing paper jams" on page 68).

Blue

On

When the machine is connected to a wireless network, WPS LED lights on blue (see
Advanced Guide).

Understanding display messages
Messages appear on the control panel display to indicate the
machine’s status or errors. Refer to the tables below to understand
the messages’ and their meaning, and correct the problem, if
necessary.

4. Troubleshooting

Message
Paper Jam
in Tray 2

9

Paper Jam

Checking display messages

in MP tray

• If a message is not in the table, reboot the power and try
the printing job again. If the problem persists, call a service
representative.
• When you call for service, provide the service
representative with the contents of display message.
• Some messages may not appear on the display depending
on the options or models.
• [error number] indicates the error number.

Paper Jam-related messages
Message
Paper Jam
in Tray 1

Meaning
Paper has jammed in
the paper feed area.

Suggested solutions
Clear the jam (see "In tray
1" on page 68).

Paper Jam
inside machine
Paper Jam
in exit area
Paper Jam
inside of duplex

Meaning
Paper has jammed in
the optional tray.
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Suggested solutions
Clear the jam (see "In
optional tray2" on page
69).

Paper has jammed in
Clear the jam (see "In the
the multi-purpose tray. multi-purpose tray" on
page 70).
Paper has jammed in
the inside machine.

Clear the jam (see "Inside
the machine" on page
70).

Paper has jammed in
the paper exit area.

Clear the jam (see "In the
exit area" on page 71).

Paper has jammed in
the duplex area.

Clear the jam (see "In the
duplex unit area" on
page 72).

Understanding display messages
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Toner-related messages
Message

Meaning

Suggested solutions

Install Toner

A toner cartridge is not installed.

Install a toner cartridge.

Not
Compatible

The toner cartridge you have installed is not for
your machine.

Install a Samsung-genuine toner cartridge, designed for your machine.

Toner
cartridge
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Understanding display messages
Message

Meaning
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Suggested solutions

The indicated toner cartridge has almost reached • You can choose Stop or Continue as shown on the control panel. If you
select Stop, the printer stops printing and you cannot print any more
its estimated cartridge life. The machine might stop
without changing the cartridge. If you select Continue, the printer
printing.
keeps printing but the printing quality cannot be guaranteed.

Replace new
cartridge

Prepare new
cartridge

• Replace the toner cartridge for the best print quality when this message
Estimated cartridge life means the
appears. Using a cartridge beyond this stage can result in printing
expected or estimated toner cartridge
quality issues (see "Replacing the toner cartridge" on page 56).
life, which indicates the average capacity
of print-outs and is designed pursuant to
ISO/IEC 19752 (see "Available supplies"
Samsung does not recommend using non-genuine Samsung
on page 51). The number of pages may
toner cartridge such as refilled or remanufactured. Samsung
be affected by operating environment,
cannot guarantee non-genuine Samsung toner cartridge's
printing interval, media type, percentage
quality. Service or repair required as a result of using nonof image area, and media size. Some
genuine Samsung toner cartridges will not be covered under the
amount of toner may remain in the
machine warranty.
cartridge even when replace new
cartridge appears and the machine stops • If the machine stops printing, replace the toner cartridge (See
printing.
"Replacing the toner cartridge" on page 56).
Small amount of toner is left in the indicated
cartridge. The estimated cartridge life of toner is
close.

Prepare a new cartridge for a replacement. You may temporarily increase
the printing quality by redistributing the toner (see "Redistributing toner"
on page 54).

Understanding display messages
Tray-related messages
Message
Paper Empty

Meaning
There is no paper in
tray 1.

Load paper in tray 1 (see
"Loading paper in the
tray/ optional tray" on
page 33).

There is no paper in
tray 2.

Load paper in tray 2 (see
"Loading paper in the
tray/ optional tray" on
page 33).

There is no paper in
the multi-purpose
tray.

Load paper in the multipurpose tray (see
"Loading in multipurpose tray" on page
35).

in Tray 1

Paper Empty
in Tray 2

Paper Empty
in MP tray

Output bin full
Remove paper

Suggested solutions

The output tray is full. Remove papers from
the output tray, the
printer resumes
printing.

4. Troubleshooting
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Understanding display messages
Network-related messages
Message
Network
Problem
IP Conflict

Meaning

Message
Suggested solutions

The network IP
Check the IP address and
address you have set is reset it if necessary (see
being used by
Advanced Guide).
someone else.
Fail to authenticate.

802.1x
Network Error

Check the network
authentication protocol.
If the problem persists,
contact your network
administrator.

Misc. messages
Message
Door Open
Close it

Error [error
number]
Call for service

Meaning

Suggested solutions

The front cover or rear Close the cover until it
cover is not securely
locks into place.
latched.
A system error has
occurred

4. Troubleshooting

Reboot the power and
try the printing job
again. If the problem
persists, please call for
service.

Error [error
number]
Turn off then on

Meaning
The machine unit
cannot be controlled.

81

Suggested solutions
Reboot the power and
try the printing job
again. If the problem
persists, please call for
service.

5. Appendix
This chapter provides product specifications and information concerning
applicable regulations.

• Specifications
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1

General specifications

The specification values listed below are subject to change without notice. See www.samsung.com/printer for possible changes in
information.

Items

Dimension

Width x Length x Height

Weight

Machine with consumables
Ready mode

Noise Levela

Temperature

Humidity

Print mode

Description
• ML-330x/ ML-331xD: 366 x 368 x 240.6 mm (14.40 x 14.48 x 9.47 inches) without
optional tray
• ML-331xND/ ML-371xD/ ML-371xND/ ML-371xDW: 366 x 368 x 252.9 mm
(14.40 x 14.48 x 9.96 inches) without optional tray
• ML-330x/ ML-331x Series: 9.74 kg (21.47 lbs)
• ML-371x Series: 9.95 kg (21.94 lbs)
26 dB (A)
• ML-330x/ ML-331x Series: 51 dB (A)
• ML-371x Series: 52 dB (A)

Operation

10 to 32°C (50 to 90°F)

Storage (packed)

-20 to 40°C (-4 to 104°F)

Operation

20 to 80% RH

Storage (packed)

10 to 90% RH

Specifications
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Items
Power ratingb

Power consumption

Wireless d

Description

110 volt models

AC 110 - 127 V

220 volt models

AC 220 - 240 V

Average operating mode

Less than 550 W

Ready mode

Less than 60 W

Power save mode

Less than 3.5 W

Power off mode

Less than 0.4 W (0.1 Wc)

Module

U98Z058

a. Sound Pressure Level, ISO 7779. Configuration tested: basic machine installation, A4 paper, simplex printing.
b. See the rating label on the machine for the correct voltage (V), frequency (hertz) and type of current (A) for your machine.
c. For the machine that has a power switch.
d. Wireless model only (see "Features by models" on page 7).
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Print media specifications

Print media weight/Capacitya
Type

Size

Dimensions
Tray1 / Optional tray

Plain paper

Letter

216 x 279 mm (8.5 x 11 inches)

Legal

216 x 356 mm (8.5 x 14 inches)

US Folio

216 x 330 mm (8.5 x 13 inches)

A4

210 x 297 mm (8.27 x 11.69 inches)

Oficio

216 x 343 mm (8.5 x 13.5 inches)

JIS B5

182 x 257 mm (7.17 x 10.12 inches)

ISO B5

176 x 250 mm (6.93 x 9.84 inches)

Executive

184 x 267 mm (7.25 x 10.5 inches)

A5

148 x 210 mm (5.83 x 8.27 inches)

A6

105 x 148 mm (4.13 x 5.83 inches)

Multi-purpose trayb

70 to 90 g/m2 (19 to 24 lbs bond) 70 to 90 g/m2 (19 to 24 lbs
bond)
• 250 sheets of 80 g/m2 (20 lbs
• The machine does not
bond) for tray1.
have a display screen: 1
• 520 sheets of 80 g/m2 (20 lbs
sheet of 80 g/m2 (20 lbs
bond) for optional tray.
bond)
• The machine has a display
screen: 50 sheets of 80 g/
m2 (20 lb bond)

• 150 sheets of 75 g/m2 (20 lbs
bond)
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Print media weight/Capacitya
Type

Size

Dimensions
Tray1 / Optional tray

Envelope
Monarch

98 x 191 mm (3.87 x 7.5 inches)

Envelope No.
10

105 x 241 mm (4.12 x 9.5 inches)

Envelope DL

110 x 220 mm (4.33 x 8.66 inches)

Envelope C5

162 x 229 mm (6.38 x 9.02 inches)

Envelope C6

114 x 162 mm (4.49 x 6.38 inches)

Thick paper

Refer to the
Plain paper
section

Multi-purpose trayb

Not available in tray1/optional
tray.

75 to 90 g/m2 (20 to 24 lbs
bond)

Refer to the Plain paper section

91 to 105 g/m2 (24 to 28 lbs
bond)

91 to 105 g/m2 (24 to 28 lbs
bond)

Refer to the Plain paper section

Thicker paper

Refer to the
Plain paper
section

Not available in tray1/optional
tray.

164 to 220 g/m2 (44 to 58 lbs
bond)

Refer to the Plain paper section

Thin paper

Refer to the
Plain paper
section

60 to 70 g/m2 (16 to 19 lbs bond) 60 to 70 g/m2 (16 to 19 lbs
bond)

Transparency

Letter, A4

Refer to the Plain paper section

Not available in tray1/optional
tray.

Envelope

138 to 146 g/m2 (36.81 to
38.91 lbs bond)
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Print media weight/Capacitya
Type

Size

Dimensions
Multi-purpose trayb

Tray1 / Optional tray
Refer to the Plain paper section

Labelsc

Letter, Legal,
US Folio, A4,
JIS B5, ISO B5,
Executive, A5

Not available in tray1/optional
tray.

120 to 150 g/m2 (32 to 40 lbs
bond)

Refer to the Plain paper section

Card stock

Letter, Legal,
US Folio, A4,
JIS B5, ISO B5,
Executive, A5

121 to 163 g/m2 ( 32 to 43 lbs
bond)

121 to 163 g/m2 (32 to 43 lbs
bond)

Refer to the Plain paper section

Bond paper

Refer to the
Plain paper
section

106 to 120 g/m2 (28 to 32 lbs
bond)

106 to 120 g/m2 (28 to 32 lbs
bond)

Minimum size (custom)

• Multi-purpose tray: 76 x 127 mm (3 60 to 163 g/m2 (16 to 43 lbs bond) d, e
x 5 inches)
Not available in optional tray.
• Tray 1: 105 x 148.5 mm (4.13 x 5.85
inches)

Maximum size (custom)

216 x 356 mm (8.5 x 14 inches)

a. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.
b. The machine does not have a display screen: 1 sheet for multi-purpose tray.
c. The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness.
d. The paper types available in multi-purpose tray: Plan, Thick, Thicker, Thin, Cotton, Colored, Pre-printed, Recycled, Envelope, Transparency, Labels, Cardstock,
Bond, Archive
e. The paper types available in tray 1: Plan, Thick, Thin, Recycled, Cardstock, Bond, Archive
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3

System requirements

Microsoft® Windows®
Requirement (recommended)
Operating system
CPU

RAM

free HDD space

Windows® 2000

Intel® Pentium® II 400 MHz (Pentium III 933 MHz)

64 MB (128 MB)

600 MB

Windows® XP

Intel® Pentium® III 933 MHz (Pentium IV 1 GHz)

128 MB (256 MB)

1.5 GB

Windows Server® 2003

Intel® Pentium® III 933 MHz (Pentium IV 1 GHz)

128 MB (512 MB)

1.25 GB to 2 GB

Windows Server® 2008

Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz)

512 MB (2 GB)

10 GB

Windows Vista®

Intel® Pentium® IV 3 GHz

512 MB (1 GB)

15 GB

Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher

1 GB (2 GB)

16 GB

Windows® 7
• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).
• DVD-R/W Drive
Windows Server® 2008 R2 Intel® Pentium® IV 1 GHz (x86) or 1.4 GHz (x64) processors (2 GHz or faster) 512 MB (2 GB)

• Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating systems.
• Users who have administrator rights can install the software.

10 GB

Specifications
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• Windows Terminal Services is compatible with your machine.
• For Windows 2000, Services Pack 4 or higher is required.

Macintosh
Requirements (Recommended)
Operating system
CPU
• Intel® processors
Mac OS X 10.3 ~ 10.4

• PowerPC G4/ G5

RAM
• 128 MB for a powerPC based
Mac (512 MB)

Free HDD space
1 GB

• 512 MB for an Intel-based Mac
(1 GB)
• Intel® processors

Mac OS X 10.5

• 867 MHz or faster Power
PC G4/ G5

Mac OS X 10.6

• Intel® processors

512 MB (1 GB)

1 GB

1 GB (2 GB)

1 GB
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Linux
Items

Requirements
Fedora 4 ~ 12 (32/ 64 bit)
OpenSuSE® 10.2, 10.3, 11.0, 11.1, 11.2 (32/64 bit)
SuSE 10.0, 10.1 (32 bit)

Operating system

Ubuntu 5.04, 5.10, 6.04, 6.10, 7.04, 7.10, 8.04, 8.10, 9.04, 9.10 (32/64 bit)
Mandriva 2005, 2006, 2007, 2008, 2009, 2009.1 (32/64 bit)
Debian 4.0, 5.0 (32/64 bit)
Redhat® Enterprise Linux WS 4, 5 (32/64 bit)
SuSE Linux Enterprise Desktop 10, 11 (32/64 bit)

CPU

Pentium IV 2.4GHz (Intel Core™2)

RAM

512 MB (1 GB)

Free HDD space

1 GB (2 GB)

Unix
Items

Requirements
Sun Solaris 9, 10 (x86, SPARC)

Operating system

HP-UX 11.0, 11i v1, 11i v2, 11i v3 (PA-RISC, Itanium)
IBM AIX 5.1, 5.2, 5.3, 5.4
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Requirements
Up to 100 MB

4

Network environment

Network and wireless models only (see "Features by models" on page 7)

You need to set up the network protocols on the machine to use it as your network machine. The following table shows the network
environments supported by the machine.
Items
Network interface

Specifications
• Ethernet 10/100/1000 Base-TX
• 802.11b/g/n Wireless LAN
• Windows 2000/Server 2003 /Server 2008/XP/Vista/7/Server 2008 R2

Network operating system

• Various Linux OS
• Mac OS X 10.3 ~ 10.6
• Unix
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Specifications
• TCP/IPv4
• DHCP, BOOTP

Network protocols

• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing (RAW), LPR, IPP, WSD
• SNMPv 1/2/3, HTTP (S), IPSec
• TCP/IPv6 (DHCP, DNS, RAW, LPR, SNMPv 1/2/3, HTTP (S), IPSec)

Wireless security

• Authentication: Open System, Shared Key, WPA Personal, WPA2 Personal (PSK), WPA
Enterprise, WPA2 Enterprise
• Encryption: WEP64, WEP128, TKIP, AES
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Regulatory information
This machine is designed for a normal work environment and
certified with several regulatory statements.

5. Appendix

When using this product, these basic safety precautions should
always be followed to reduce risk of fire, electric shock, and injury to
persons:

5

Laser safety statement
The printer is certified in the U.S. to conform to the requirements of
DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products,
and elsewhere is certified as a Class I laser product conforming to the
requirements of IEC 60825-1 : 2007.
Class I laser products are not considered to be hazardous. The laser
system and printer are designed so there is never any human access
to laser radiation above a Class I level during normal operation, user
maintenance or prescribed service condition.
6

Warning
Never operate or service the printer with the protective cover
removed from laser/scanner assembly. The reflected beam,
although invisible, can damage your eyes.
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Taiwan only

Regulatory information
7
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9

Ozone safety

Recycling

This product's ozone emission rate is under 0.1 ppm.
Because ozone is heavier than air, keep the product in
a place with good ventilation.

Recycle or dispose of the packaging material for this
product in an environmentally responsible manner.

8
10

Power saver

This printer contains advanced energy conservation
technology that reduces power consumption when it is
not in active use.
When the printer does not receive data for an extended
period of time, power consumption is automatically
lowered.
ENERGY STAR and the ENERGY STAR mark are
registered U.S. marks.
For more information on the ENERGY STAR program
see http://www.energystar.gov

China only
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The United States of America only

11

Correct disposal of this product (Waste
electrical & electronic equipment)

(Applicable in the european union and other
european countries with separate collection
systems)
This marking on the product, accessories or literature
indicates that the product and its electronic accessories (e.g.
charger, headset, USB cable) should not be disposed of with
other household waste at the end of their working life. To
prevent possible harm to the environment or human health
from uncontrolled waste disposal, please separate these
items from other types of waste and recycle them responsibly
to promote the sustainable reuse of material resources.
Household users should contact either the retailer where they
purchased this product, or their local government office, for
details of where and how they can take these items for
environmentally safe recycling.
Business users should contact their supplier and check the
terms and conditions of the purchase contract. This product
and its electronic accessories should not be mixed with other
commercial wastes for disposal.

Dispose unwanted electronics through an approved recycler. To find
the nearest recycling location, go to our
website:www.samsung.com/recyclingdirect Or call, (877) 278 - 0799
12

Radio frequency emissions

FCC information to the user
This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions:
•

This device may not cause harmful interference, and

•

This device must accept any interference received, including
interference that may cause undesired operation.

Regulatory information
This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

5. Appendix
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Canadian radio interference regulations
This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interferencecausing equipment standard entitled “Digital Apparatus”, ICES-003
of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B
prescrites dans la norme sur le matériel brouilleur: “Appareils
Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.
13

•

Reorient or relocate the receiving antenna.

•

Increase the separation between the equipment and receiver.

•

Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

Federal communications commission (FCC)

•

Consult the dealer or experienced radio TV technician for help.

► Intentional emitter per FCC Part 15

Change or modifications not expressly approved by the
manufacturer responsible for compliance could void the
user's authority to operate the equipment.

United states of america

Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz Band, may
be present (embedded) in your printer system. This section is only
applicable if these devices are present. Refer to the system label to
verify the presence of wireless devices.
Wireless devices that may be in your system are only qualified for use
in the United States of America if an FCC ID number is on the system
label.

Regulatory information
The FCC has set a general guideline of 20 cm (8 inches) separation
between the device and the body, for use of a wireless device near
the body (this does not include extremities). This device should be
used more than 20 cm (8 inches) from the body when wireless
devices are on. The power output of the wireless device (or devices),
which may be embedded in your printer, is well below the RF
exposure limits as set by the FCC.

5. Appendix

FCC statement for wireless LAN use:

While installing and operating this transmitter and antenna
combination the radio frequency exposure limit of 1m W/
cm2 may be exceeded at distances close to the antenna
installed. Therefore, the user must maintain a minimum
distance of 20cm from the antenna at all times. This device
cannot be colocated with another transmitter and
transmitting antenna.

This transmitter must not be collocated or operation in conjunction
with any other antenna or transmitter.
Operation of this device is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this
device must accept any interference received, including interference
that may cause undesired operation of the device.

Wireless devices are not user serviceable. Do not modify
them in any way. Modification to a wireless device will void
the authorization to use it. Contact manufacturer for service.
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Taiwan only

Regulatory information
15
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18

Russia only

Replacing the fitted plug (for UK only)

Important

16

Germany only

The mains lead for this machine is fitted with a standard (BS 1363) 13
amp plug and has a 13 amp fuse. When you change or examine the
fuse, you must re-fit the correct 13 amp fuse. You then need to
replace the fuse cover. If you have lost the fuse cover, do not use the
plug until you have another fuse cover.
Contact the people from you purchased the machine.

17

Turkey only

The 13 amp plug is the most widely used type in the UK and should
be suitable. However, some buildings (mainly old ones) do not have
normal 13 amp plug sockets. You need to buy a suitable plug
adaptor. Do not remove the moulded plug.

If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric
shock if you plug it into a socket.

Regulatory information
Important warning:
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19

Declaration of conformity (European
countries)
You must earth this machine.
The wires in the mains lead have the following color code:

Approvals and Certifications

• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your
plug, do the following:
You must connect the green and yellow wire to the pin marked by
the letter “E” or by the safety ‘Earth symbol’ or colored green and
yellow or green.
You must connect the blue wire to the pin which is marked with the
letter “N” or colored black.
You must connect the brown wire to the pin which is marked with
the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the
distribution board.

Hereby, Samsung Electronics, declares that this [ML371xDW] is in compliance with the essential requirements
and other relevant provisions of R&TTE Directive 1999/5/EC.
Hereby, Samsung Electronics, declares that this [ML-330x
Series, ML-331x Series, ML-371x Series] is in compliance with
the essential requirements and other relevant provisions of
Low Voltage Directive (2006/95/EC), EMC Directive (2004/
108/EC).
The declaration of conformity may be consulted at
www.samsung.com/printer, go to Support > Download
center and enter your printer (MFP) name to browse the
EuDoC.

January 1, 1995: Council Directive 2006/95/EC Approximation of
the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC, approximation of
the laws of the Member States related to electromagnetic
compatibility.

Regulatory information
March 9, 1999: Council Directive 1999/5/EC on radio equipment
and telecommunications terminal equipment and the mutual
recognition of their conformity. A full declaration, defining the
relevant Directives and referenced standards can be obtained from
your Samsung Electronics Co., Ltd. representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications
Terminal Equipment Directive (FAX)
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European radio approval information (for products
fitted with EU-approved radio devices)
Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz band, may
be present (embedded) in your printer system which is intended for
home or office use. This section is only applicable if these devices are
present. Refer to the system label to verify the presence of wireless
devices.
Wireless devices that may be in your system are
only qualified for use in the European Union or
associated areas if a CE mark with a Notified
Body Registration Number and the Alert
Symbol is on the system label.

This Samsung product has been self-certified by Samsung for panEuropean single terminal connection to the analogue public
switched telephone network (PSTN) in accordance with Directive
1999/5/EC. The product has been designed to work with the national
PSTNs and compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of
Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and
application of terminal equipment which complies with this
standard, the European Telecommunication Standards Institute
(ETSI) has issued an advisory document (EG 201 121) which contains
notes and additional requirements to ensure network compatibility
of TBR21 terminals. The product has been designed against, and is
fully compliant with, all of the relevant advisory notes contained in
this document.
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The power output of the wireless device or devices that may be
embedded in you printer is well below the RF exposure limits as set
by the European Commission through the R&TTE directive.

► European states qualified under wireless approvals:
EU countries

► European states with restrictions on use:
EU
In France, the frequency range is restricted to 2454-2483.5 MHz for
devices above 10 mW transmitting power such as wireless

Regulatory information
EEA/EFTA countries
No limitations at this time
20

Regulatory compliance statements

Wireless guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless
communication devices), operating in the 2.4 GHz/5 GHz Band, may
be present (embedded) in your printer system. The following section
is a general overview of considerations while operating a wireless
device.
Additional limitations, cautions, and concerns for specific countries
are listed in the specific country sections (or country group sections).
The wireless devices in your system are only qualified for use in the
countries identified by the Radio Approval Marks on the system
rating label. If the country you will be using the wireless device in, is
not listed, contact your local Radio Approval agency for
requirements. Wireless devices are closely regulated and use may
not be allowed.
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The power output of the wireless device or devices that may be
embedded in your printer is well below the RF exposure limits as
known at this time. Because the wireless devices (which may be
embedded into your printer) emit less energy than is allowed in
radio frequency safety standards and recommendations,
manufacturer believes these devices are safe for use. Regardless of
the power levels, care should be taken to minimize human contact
during normal operation.
As a general guideline, a separation of 20 cm (8 inches) between the
wireless device and the body, for use of a wireless device near the
body (this does not include extremities) is typical. This device should
be used more than 20 cm (8 inches) from the body when wireless
devices are on and transmitting.
This transmitter must not be collocated or operation in conjunction
with any other antenna or transmitter.
Some circumstances require restrictions on wireless devices.
Examples of common restrictions are listed below:
Radio frequency wireless communication can interfere with
equipment on commercial aircraft. Current aviation
regulations require wireless devices to be turned off while
traveling in an airplane. IEEE 802.11 (also known as wireless
Ethernet) and Bluetooth communication devices are
examples of devices that provide wireless communication.

Regulatory information
In environments where the risk of interference to other
devices or services is harmful or perceived as harmful, the
option to use a wireless device may be restricted or
eliminated. Airports, Hospitals, and Oxygen or flammable gas
laden atmospheres are limited examples where use of
wireless devices may be restricted or eliminated. When in
environments where you are uncertain of the sanction to use
wireless devices, ask the applicable authority for
authorization prior to use or turning on the wireless device.
Every country has different restrictions on the use of wireless
devices. Since your system is equipped with a wireless device,
when traveling between countries with your system, check
with the local Radio Approval authorities prior to any move or
trip for any restrictions on the use of a wireless device in the
destination country.
If your system came equipped with an internal embedded
wireless device, do not operate the wireless device unless all
covers and shields are in place and the system is fully
assembled.
Wireless devices are not user serviceable. Do not modify them
in any way. Modification to a wireless device will void the
authorization to use it. Contact manufacturer for service.
Only use drivers approved for the country in which the device
will be used. See the manufacturer System Restoration Kit, or
contact manufacturer Technical Support for additional
information.
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Israel only
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Regulatory information
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China only
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Copyright

5. Appendix

104

© 2010 Samsung Electronics Co., Ltd. All rights reserved.
This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.
Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.
•

Samsung and the Samsung logo are trademarks of Samsung Electronics Co., Ltd.

•

Microsoft, Windows, Windows Vista, Windows 7, and Windows Server 2008 R2 are either registered trademarks or trademarks of Microsoft
Corporation.

•

TrueType, LaserWriter, and Macintosh are trademarks of Apple Computer, Inc.

•

All other brand or product names are trademarks of their respective companies or organizations.

Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.
REV. 1.08
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1. Software installation
This chapter provides instructions for installing essential and helpful software
for use in an environment where the machine is connected via a cable. A locally
connected machine is a machine directly attached to your computer using the
cable. If your machine is attached to a network, skip the following steps below
and go on to installing a network connected machine’s driver (see Installing
driver over the network17).

• Installation for Macintosh

5

• Reinstallation for Macintosh

7

• Installation for Linux

8

• Reinstallation for Linux
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• If you are a Windows OS user, refer to the Basic Guide for installing the
machine’s driver.
• Only use a USB cable no longer then 3 meter (118 inches).

Installation for Macintosh

1. Software installation

5

1

Make sure that the machine is connected to your computer
and powered on.

Typical installation for a local printer and then click
11 Select
OK.

2
3

Insert the supplied software CD into your CD-ROM drive.

4
5
6
7
8
9

Double-click the MAC_Installer folder > Installer OS X icon.

12 Click Continue on the Read Me window.
13 After the installation is finished, click Quit.
Open the Applications folder > Utilities > Print Setup
14 Utility.

Double-click the CD-ROM icon that appears on your
Macintosh desktop.

Enter the password and click OK.
Click Continue.
Read the license agreement and click Continue.
Click Agree to agree to the license agreement.
Select Easy Install and click Install. Easy Install is
recommended for most users. All components necessary for
machine operations will be installed.
If you select Custom Install, you can choose individual
components to install.

the message that warns that all applications will close
10 When
on your computer appears, click Continue.

•

For Mac OS X 10.5-10.6, open the Applications folder >
System Preferences and click Print & Fax.

15 Click Add on the Printer List.
•

For Mac OS X 10.5-10.6, click the “+” icon; a display window
will pop up.

16 For Mac OS X 10.3, select the USB tab.
•

For Mac OS X10.4, click Default Browser and find the USB
connection.

•

For Mac OS X 10.5-10.6, click Default and find the USB
connection.

Installation for Macintosh
Mac OS X 10.3, if Auto Select does not work properly, select
17 For
Samsung in Printer Model and your machine name in Model
Name.
•

For Mac OS X 10.4, if Auto Select does not work properly,
select Samsung in Print Using and your machine name in
Model.

•

For Mac OS X 10.5-10.6, if Auto Select does not work
properly, select Select a driver to use... and your machine
name in Print Using.

Your machine appears on the Printer List, and is set as the
default machine.

18 Click Add.

1. Software installation
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Reinstallation for Macintosh
If the printer driver does not work properly, uninstall the driver and
reinstall it.

1

Make sure that the machine is connected to your computer
and powered on.

2
3

Insert the supplied software CD into your CD-ROM drive.
Double-click the CD-ROM icon that appears on your
Macintosh desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.
5 Enter the password and click OK.
6 Click Continue.
7 Read the license agreement and click Continue.
8 Click Agree to agree to the license agreement.
9 Select Uninstall and click Uninstall.
the message which warns that all applications will close
10 When
on your computer appears, click Continue.
11 When the uninstall is done, click Quit.

1. Software installation

7

If a machine has already been added, delete it from the Print
Setup Utility or Print & Fax.

Installation for Linux

1. Software installation

6
7

You need to download Linux software packages from the Samsung
website to install the printer software (http://www.samsung.com/
printer).
1

Installing the Unified Linux Driver

1

Make sure that the machine is connected to your computer
and powered on.

2

When the Administrator Login window appears, type “root”
in the Login field and enter the system password.

You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

3

Right-click the Unified Linux Driver package and extract the
package.

5

Double click cdroot > autorun.

When the welcome screen appears, click Next.
When the installation is complete, click Finish.

The installation program added the Unified Driver Configurator
desktop icon and the Unified Driver group to the system menu for
your convenience. If you have any difficulties, consult the on-screen
help that is available through your system menu or from the driver
package Windows applications, such as Unified Driver
Configurator or Image Manager.
2

Installing the Smart Panel

1

Make sure that the machine is connected to your computer
and powered on.

2

When the Administrator Login window appears, type in root
in the Login field and enter the system password.

From the Samsung website, download the Unified Linux
Driver package to your computer.

4

8

You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

3

From the Samsung website, download the Smart Panel
package to your computer.

Installation for Linux
4
5

Right-click the Smart Panel package and extract the package.
Double click cdroot > Linux > smartpanel > install.sh.

3

Installing the Printer Settings Utility

1

Make sure that the machine is connected to your computer
and powered on.

2

When the Administrator Login window appears, type “root”
in the Login field and enter the system password.

You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

3

From the Samsung website, download the Printer Settings
Utility package to your computer.

4

Right-click the Printer Settings Utility package and extract
the package.

5

Double click cdroot > Linux > psu > install.sh.

1. Software installation

9

Reinstallation for Linux
If the printer driver does not work properly, uninstall the driver and
reinstall it.

1

Make sure that the machine is connected to your computer
and powered on.

2

When the Administrator Login window appears, type “root”
in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer
driver. If you are not a super user, ask your system
administrator.

3

Click the icon at the bottom of the desktop. When the
Terminal screen appears, type in the following.
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

4
5
6

Click Uninstall.
Click Next.
Click Finish.

1. Software installation
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2. Using a network-connected
machine
This chapter gives you step-by-step instructions for setting up a network
connected machine and software.

• Useful network programs

12

• Wired network setup

13

• Installing driver over the network

17

• IPv6 configuration

24

• Wireless network setup

27

Useful network programs
There are several programs available to setup the network settings
easily in a network environment. For the network administrator
especially, managing several machines on the network is possible.

Before using the programs below, set the IP address first.

1



2. Using a network-connected machine
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2



 SyncThru™ Web Admin Service

Web-based machine management solution for network
administrators. SyncThru™ Web Admin Service provides you with an
efficient way of managing network devices and lets you remotely
monitor and troubleshoot network machines from any site with
corporate internet access. Download this program from http://
solution.samsungprinter.com.

 SyncThru™ Web Service
3

The web server embedded on your network machine allows you to
do the following tasks (see "Using SyncThru™ Web Service" on page
26):



 SetIP

•

Check the supplies information and status.

This utility program allows you to select a network interface and
manually configure the IP addresses for use with the TCP/IP protocol.

•

Customize machine settings.

•

See "IPv4 configuration using SetIP (Windows)" on page 13.

•

Set the email notification option. When you set this option, the
machine status (toner cartridge shortage or machine error) will
be sent to a certain person's email automatically.

•

See "IPv4 configuration using SetIP (Macintosh)" on page 14.

•

See "IPv4 configuation using SetIP (Linux)" on page 15.

•

Configure the network parameters necessary for the machine to
connect to various network environments.

TCP/IPv6 is not supported by this program.

Wired network setup

2. Using a network-connected machine

You must set up the network protocols on your machine to use it on
your network.

Using this Network Configuration Report, you can find your
machine’s MAC address and IP address.

You can use network after connecting network cable to a
corresponding port on your machine.

For example:

•

•

For models that do not have the display screen on the control
panel, use the SyncThru™ Web Service or SetIP program.
-

See "Using SyncThru™ Web Service" on page 93.

-

See "Setting IP address" on page 13.

For models that have the display screen on the control panel,
configure the network setting by pressing
(Menu) button >
Network on the control panel (see "Network" on page 64).

4



 Printing a network configuration report

You can print Network Configuration Report from the machine’s
control panel that will show the current machine’s network settings.
This will help you to set up a network.
•

•

The machine has the display screen: Press the
(Menu)
button on the control panel and select Network > Network
Config. (Network Configuration)> Yes.
The machine does not have the display screen: Press the
(Cancel or Stop/Clear) button for more than five seconds on the
control panel.

•

MAC Address: 00:15:99:41:A2:78

•

IP Address: 192.0.0.192

13

5



 Setting IP address

First, you have to set up an IP address for network printing and
managements. In most cases a new IP address will be automatically
assigned by a DHCP (Dynamic Host Configuration Protocol) server
located on the network.

IPv4 configuration using SetIP (Windows)
Before using the SetIP program, disable the computer firewall from
Control Panel > Security Center > Windows Firewall.

1

Install this program from the supplied CD-ROM by doubleclick Application > SetIP > Setup.exe.

2
3

Follow the instructions in the installation window.
Connect your machine to the network with a network cable.

Wired network setup
4
5

From the Windows Start menu, select All Programs >
Samsung Printers > SetIP > SetIP.

6

Click the icon (third from left) in the SetIP window to open
the TCP/IP configuration window.

7

Enter the machine’s new information into the configuration
window as follows. In a corporate intranet, you may need to
have this information assigned by a network manager before
proceeding.

2. Using a network-connected machine
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Turn on the machine.
Find the machine’s MAC address from the Network
Configuration Report (see "Printing a network
configuration report" on page 13) and enter it without the
colons. For example, 00:15:99:29:51:A8 becomes
0015992951A8.

8

Click Apply, and then click OK. The machine will automatically
print the Network Configuration Report. Confirm that all the
settings are correct.

IPv4 configuration using SetIP (Macintosh)
Before using the SetIP program, disable the computer firewall from
System Preferences > Security > Firewall.

The following instructions may vary from your model.

1
2

Connect your machine to the network with a network cable.
Insert the Installation CD-ROM, and open the disk window,
select MAC_Installer > MAC_Printer > SetIP >
SetIPapplet.html.

Wired network setup
3

Double-click the file and Safari will automatically open, then
select Trust. The browser will open the SetIPapplet.html
page that shows the printer’s name and IP address
information.

4

Click the
icon (third from left) in the SetIP window to open
the TCP/IP configuration window.

5

Enter the machine’s new information into the configuration
window. In a corporate intranet, you may need to have this
information assigned by a network manager before
proceeding.

Find the machine’s MAC address from the Network
Configuration Report (see "Printing a network
configuration report" on page 13) and enter it without the
colons. For example, 00:15:99:29:51:A8 becomes
0015992951A8.

6
7

Select Apply, then OK, and OK again.
Quit Safari.

2. Using a network-connected machine
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IPv4 configuation using SetIP (Linux)
Before using the SetIP program, disable the computer firewall from
System Preferences or Administrator.

The following instructions may vary from your model or
operating systems.

1
2
3
4

Open /opt/Samsung/mfp/share/utils/.
Double-click the SetIPApplet.html file.
Click to open the TCP/IP configuration window.
Enter the machine’s new information into the configuration
window. In a corporate intranet, you may need to have this
information assigned by a network manager before
proceeding.

Find the machine’s MAC address from the Network
Configuration Report (see "Printing a network
configuration report" on page 13) and enter it without the
colons. For example, 00:15:99:29:51:A8 becomes
0015992951A8.

Wired network setup
5

The machine will automatically print the Network
Configuration Report.

2. Using a network-connected machine
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Installing driver over the network
6



 Windows

4

2. Using a network-connected machine
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Read License Agreement, and select I accept the terms of
the License Agreement. Then, click Next.
The program searches for the machine.

1

Make sure that the machine is connected to the network and
powered on. Also, your machine’s IP address should have
been set (see "Setting IP address" on page 13).

If the “Found New Hardware Wizard” appears during the
installation procedure, click Cancel to close the window.

2

Insert the supplied software CD into your CD-ROM drive.

3

Select Install Now.

The software CD should automatically run and an installation
window will appear.

When you click the Advanced Installation, you can use the
Custom Installation option. The Custom Installation
allows you to select the machine’s connection and choose
individual components to install. Follow the instructions on
the window.

If your machine is not found on the network or locally, an
error message appears.
• Check if you want to install the software without
connection of the printer.
- Check this option to install this program without a
machine connected. In this case, the print a test page
window will be skipped, and completes the installation.
• Search again
When you press this button, the firewall notice window
appears.
- Turn off the firewall and Search again. For Windows
operating system, click Start > Control Panel >
Windows Firewall, and inactivate this option.
- Turn off the firewall from the third party's program
beside the operating system. Refer to the manual
provided by individual programs.

Installing driver over the network
• Direct Input
The Direct Input allows you to search for a specific
machine on the network.
- Search by IP address: Enter the IP address or the host
name. Then click Next.
To verify your machine’s IP address, print a network
configuration report (see "Printing a network
configuration report" on page 13).
- Search by network path: To find a shared machine
(UNC Path), enter the shared name manually or find a
shared printer by clicking the Browse button. Then click
Next.
• Help
If your machine is not connected to the computer or
network, this help button gives detailed information
about how to connect the machine.
• SNMP Community Name
If your system administrator set the new SNMP
Community Name on the machine, you can find the
machine in the network. Contact your system
administrator for new SNMP Community Name.

5

The searched machines will be shown on the screen. Select
the one you wish to use and click OK.

2. Using a network-connected machine
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If the driver searched only one machine, the confirmation
window appears.

6

Follow the instructions in the installation window.

7



 Macintosh

1

Make sure that the machine is connected to your network and
powered on. Also, your machine’s IP address should have
been set (see "Setting IP address" on page 13).

2
3

Insert the supplied software CD into your CD-ROM drive.

4
5
6
7

Double-click the MAC_Installer folder > Installer OS X icon.

Double-click the CD-ROM icon that appears on your
Macintosh desktop.

Enter the password and click OK.
Click Continue.
Read the license agreement and click Continue.

Installing driver over the network
8
9

Click Agree to agree to the license agreement.
Select Easy Install and click Install. Easy Install is
recommended for most users. All components necessary for
machine operations will be installed.
If you select Custom Install, you can choose individual
components to install.

the message which warns that all applications will close
10 When
on your computer appears, click Continue.
Typical installation for a network printer and then
11 Select
click OK.

12 The SetIP program automatically runs.
13 Click OK to continue the installation.
14 Click Continue on the Read me window.
15 After the installation is finished, click OK.

2. Using a network-connected machine
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Open the Applications folder > Utilities > Print Setup
16 Utility.
•

For Mac OS X 10.5-10.6, open the Applications folder >
System Preferences and click Print & Fax.

17 Click Add on the Printer List.
•

For Mac OS X 10.5-10.6, click the “+” icon. A display window
will pop up.

18 For Mac OS X 10.3, select the IP Printing tab.
•

For Mac OS X 10.4, click IP Printer.

•

For Mac OS X 10.5-10.6, click IP.

19 Select HP Jetdirect - Socket in Protocol.
When printing a document containing many pages, printing
performance may be enhanced by choosing Socket for
Printer Type option.

20 Enter the machine’s IP address in the Address input field.
the queue name in the Queue input field. If you cannot
21 Enter
determine the queue name for your machine server, try using
the default queue first.

Installing driver over the network
Mac OS X 10.3, if Auto Select does not work properly, select
22 For
Samsung in Printer Model and your machine name in Model
Name.
•

For Mac OS X 10.4, if Auto Select does not work properly,
select Samsung in Print Using and your machine name in
Model.

•

For Mac OS X 10.5-10.6, if Auto Select does not work
properly, choose Select Printer Software and your
machine name in Print Using.

8



 Linux

You need to download Linux software packages from the Samsung
website to install the printer software (http://www.samsung.com/
printer).

To install other software:
• See "Installing the Smart Panel" on page 8.
• See "Installing the Printer Settings Utility" on page 9.

20

Install the Linux driver and add network printer

1

Make sure that the machine is connected to your network and
powered on. Also, your machine’s IP address should have
been set.

2

Download the Unified Linux Driver package from the
Samsung website.

3

Extract the UnifiedLinuxDriver.tar.gz file and open the new
directory.

4
5
6
7
8

Double-click the Linux folder > install.sh icon.

23 Click Add.

Your machine appears in the Printer List, and is set as the
default machine.

2. Using a network-connected machine

The Samsung installer window opens. Click Continue.
The add printer wizard window opens. Click Next.
Select network printer and click Search button.
The machine’s IP address and model name appears on list
field.

9 Select your machine and click Next.
10 Input the printer description and Next.

Installing driver over the network
11
12 When installation is done, click Finish.

After the machine is added, click Finish.



The Add printer wizard window opens. Click Next.

 UNIX

Make sure your machine supports the UNIX operating
system before installing the UNIX printer driver (see basic
guide)

Double-click the Unified Driver Configurator.
Click Add Printer.

21

9

Add a network printer

1
2
3
4
5
6
7
8

2. Using a network-connected machine

To use the UNIX printer driver, you have to install the UNIX printer
driver package first, then setup the printer. You can download the
UNIX printer driver package from the Samsung website.

Select Network printer and click the Search button.

Installing the UNIX printer driver package

The printer’s IP address and model name appears on list field.

The installation procedure is common for all variants of UNIX OS
mentioned.

Select your machine and click Next.
Enter the printer description and click Next.
After the machine is added, click Finish.

1

From the Samsung website, download and unpack the UNIX
Printer Driver package to your computer.

2

Acquire root privileges.

3

Copy the appropriate driver archive to the target UNIX
computer.

su -

Installing driver over the network
See administration guide of your UNIX OS for details.

4

Unpack the UNIX printer driver package archive.

2. Using a network-connected machine
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8

Execute the “. /install –c” command to verify installation
results.

9

Run ‘installprinter’ from the command line. This will bring up
the Add Printer Wizard window. Setup the printer in this
window referring to the following procedures.

For example, on IBM AIX uses the following commands.
cd /tmp
gzip –dc /cdrom/unix/packages/aix_power/
aix_power.tar.gz | tar –xvf –
The “binaries” folder consists of binz, install, share files and
folders.

On some UNIX OS, for example on Solaris 10, just added
printers may not be enabled and/or may not accept jobs. In
this case run the following two commands on the root
terminal:
accept <printer_name>
enable <printer_name>

5
6
7

Copy the “binaries” folder to any local folder.
Change to the driver’s “binaries” directory.

Uninstalling the printer driver package

cd aix_power/binaries
Run the install script.
./install
install is the installer script file which is used to install or
uninstall the UNIX Printer Driver package.
Use “chmod 755 install” command to give the permission to
the installer script.

The utility should be used to delete the printer installed in
the system.
a Run “uninstallprinter” command from the terminal.
It will open the Uninstall Printer Wizard.
The installed printers are listed in the drop-down list.
b Select the printer to be deleted.
c Click Delete to delete the printer from the system.

Installing driver over the network
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d Execute the “. /install –d” command to uninstall the whole
package.
e To verify removal results, execute the “. /install –c”
command.

6

Type the IP address or DNS name of the printer in the Device
textbox for network-connected printers. On IBM AIX with
jetdirect Queue type, only the DNS name is possible-numeric
IP address is not allowed.

To re-install it, use the command “. /install” to reinstall the binaries.

7

Queue type shows the connection as lpd or jetdirect in the
corresponding list box. Additionally, usb type is available on
Sun Solaris OS.

Setting up the printer
To add the printer to your UNIX system, run ‘installprinter’ from the
command line. This will bring up the Add Printer Wizard window.
Setup the printer in this window according to the following steps:

1
2
3

Type the name of the printer.

4

Specify any printer description in the Description field. This is
optional.

5

Specify the printer location in the Location field.

Select the appropriate printer model from the model list.
Enter any description corresponding to the type of the printer
in the Type field. This is optional.

8 Select Copies to set the number of copies.
9 Check the Collate option to receive copies already sorted.
the Reverse Order option to receive copies in the
10 Check
reverse order.
11 Check the Make Default option to set this printer as default.
12 Click OK to add the printer.

IPv6 configuration

2. Using a network-connected machine
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IPv6 is supported properly only in Windows Vista or higher.

24

The Add Printer Wizard window appears. Follow the
instructions in the window.

If the machine does not work in the network environment,
activate IPv6. Refer to the next section followed by.
If the IPv6 network seems to not be working, set all the
network setting to the factory defaults and try again using
Clear Setting (see "Network" on page 64).

10


In the IPv6 network environment, follow the next procedure to use
the IPv6 address.

1
2
3
4
5
6

Connect your machine to the network with a network cable.
Turn on the machine.
Print a Network Configuration Report that will check IPv6
addresses (see "Printing a network configuration report" on
page 13).
Select Start > Control Panel > Printers and Faxes.
Click Add a printer in the left pane of the Printers and Faxes
windows.
Click Add a local printer in the Add Printer windows.

1
2
3
4
5

 Activating IPv6
Press the

(Menu) button on the control panel.

Press Network > TCP/IP (IPv6) > IPv6 Activate.
Select On and press OK.
Turn the machine off and turn it on again.
Reinstall your printer driver.

IPv6 configuration
11



 Setting IPv6 addresses

2. Using a network-connected machine

3

The machine supports the following IPv6 addresses for network
printing and managements.
•

Link-local Address: Self-configured local IPv6 address (Address
starts with FE80).

•

Stateless Address: Automatically configured IPv6 address by a
network router.

•

Stateful Address: IPv6 address configured by a DHCPv6 server.

•

Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)
If you have a DHCPv6 server on your network, you can set one of the
following options for default dynamic host configuration.

1
2

Press the

(Menu) button on the control panel.

Press Network > OK > TCP/IP (IPv6) > OK > DHCPv6 Config.

25

Press OK to select the required value you want.
•

DHCPv6 Addr.: Always use DHCPv6 regardless of router
request.

•

DHCPv6 Off: Never use DHCPv6 regardless of router
request.

•

Router: Use DHCPv6 only when requested by a router.

Manual address configuration

1

Start a web browser, such as Internet Explorer, that supports
IPv6 addressing as a URL.

2

When the SyncThru™ Web Service window opens, move the
mouse cursor over the Settings of the top menu bar and then
click Network Settings.

3
4

Click TCP/IPv6 on the left pane of the website.

5

Enter the rest of the address (e.g.,:3FFE:10:88:194::AAAA. “A” is
the hexadecimal 0 through 9, A through F).

6

Click the Apply button.

Select the Manual Address check box. Then, the Address/
Prefix text box is activated.

IPv6 configuration
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 Using SyncThru™ Web Service

1

Start a web browser, such as Internet Explorer, that supports
IPv6 addressing as a URL.

2

Select one of the IPv6 addresses (Link-local Address,
Stateless Address, Stateful Address, Manual Address) from
Network Configuration Report (see "Printing a network
configuration report" on page 13).

3

Enter the IPv6 addresses (e.g.,: http://
[FE80::215:99FF:FE66:7701]).

Address must be enclosed in '[ ]' brackets.

2. Using a network-connected machine
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Wireless network name and network key
Make sure your machine supports a wireless network.
Wireless network may not be available depending on the
model.

Wireless networks require higher security, so when an access point is
first set up, a network name (SSID), the type of security used, and a
Network Key are created for the network. Locate this information
before proceeding with the machine installation.

13



 Getting started
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 Choosing the installation type

Understanding your network type
Typically, you can only have one connection between your
computer and the machine at a time.
Infrastructure mode
This is an environment generally used for homes and
SOHOs (Small Office/ Home Office). This mode uses
an access point to communicate with the wireless
machine.

You can install a wireless network from the machine’s control panel
or the computer.

From the control panel
For most users, we recommend using the
configure the wireless network settings.
•

(WPS): If your machine and an access point (or wireless router)
support Wi-Fi Protected Setup™ (WPS), you can easily configure
the wireless network settings by pressing the (WPS) button on
the control panel (see "Using the WPS button" on page 28).

•

Control panel: You can configure wireless parameters with the
control panel (see "Using the menu button" on page 32 ).

Ad hoc mode
This mode does not use an access point. The wireless
computer and wireless machine communicates
directly.

(WPS) button to

Wireless network setup
From the computer

2. Using a network-connected machine
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From the computer, we recommend using a USB cable with the
program provided in the supplied software CD.
See "Setup using Windows" on page 34.
•

With a USB cable: You can simply set up a wireless network
using the program on the supplied software CD. Only Windows
and Macintosh operating systems are supported (see "Setup
using Windows" on page 34 or "Setup using Macintosh" on page
42).

With a network cable: You can set up a wireless network using
the SyncThru™ Web Service program (see "Using a network
cable" on page 48).

 Using the WPS button

If your machine and an access point (or wireless router) support WiFi Protected Setup™ (WPS), you can easily configure the wireless
network settings by pressing the
(WPS) button on the control
panel without a computer.

If you want to use the wireless network using the
infrastructure mode, make sure that the network cable is
disconnected from the machine. Using the WPS (PBC)
button or entering the PIN from the computer to connect to
the access point (or wireless router) varies depending on the
access point (or wireless router) you are using. Refer to the
user's guide of the access point (or wireless router) you are
using.

You can also install a wireless network in Printer Settings
Utility with a USB cable after installing the driver (Windows
and Macintosh operating systems are supported).

•

28

Items to prepare
•

Check if the access point (or wireless router) supports Wi-Fi
Protected Setup™ (WPS).

•

Check if your machine supports Wi-Fi Protected Setup™ (WPS).

•

Networked computer (PIN mode only)

Wireless network setup

2. Using a network-connected machine

Choosing your type

Machines with an display screen

There are two methods available to connect your machine to a
wireless network using the
(WPS) button on the control panel.

► Connecting in PBC mode

The Push Button Configuration (PBC) method allows you to
connect your machine to a wireless network by pressing both the
(WPS) button on the control panel of your machine and the WPS
(PBC) button on a Wi-Fi Protected Setup™ (WPS)-enabled access
point (or wireless router) respectively.
The Personal Identification Number (PIN) method helps you
connect your machine to a wireless network by entering the
supplied PIN information on a Wi-Fi Protected Setup™ (WPS)enabled access point (or wireless router).
Factory default in your machine is PBC mode, which is
recommended for a typical wireless network environment.

To change the WPS mode , press
Wireless > OK > WPS Setting.

(Menu) > Network >

1
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Press and hold the
(WPS) button on the control panel for
more than 2 seconds.
The machine starts waiting for up to two minutes until you
press the WPS (PBC) button on the access point (or wireless
router).

2

Press the WPS (PBC) button on the access point (or wireless
router).
The messages are displayed on the display screen in the order
below:
a Connecting: The machine is connecting to the access
point (or wireless router).
b Connected: When the machine is successfully connected
to the wireless network, the WPS LED light stays on.
c AP SSID: After completing the wireless network
connection process, the AP’s SSID information appears on
the display.

Wireless network setup
► Connecting in PIN mode

1

Press and hold the
(WPS) button on the control panel for
more than 2 seconds.

2

The eight-digit PIN appears on the display.

2. Using a network-connected machine

Machines without an display screen
► Connecting in PBC mode

1

You need to enter the eight-digit PIN within two minutes to
the computer which is connected to the access point (or
wireless router).
The messages are displayed on the display screen in the order
below:
a Connecting: The machine is connecting to the wireless
network.
b Connected: When the machine is successfully connected
to the wireless network, the WPS LED light stays on.
c AP SSID: After completing the wireless network
connection process, the AP’s SSID information is diplayed
on the LCD display.
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Press and hold the
(WPS) button on the control panel for
about 2 - 4 seconds until the status LED blinks quickly.
The machine starts connecting to the wireless network. The
LED blinks slowly for up to two minutes until you press the PBC
button on the access point (or wireless router).

2

Press the WPS (PBC) button on the access point (or wireless
router).
a The light blinks fast on the WPS LED. The machine is
connecting to the access point (or wireless router).
b When the machine is successfully connected to the
wireless network, the WPS LED light stays on.

Wireless network setup
► Connecting in PIN mode

1

The network configuration report, including PIN, must be
printed.
In ready mode, press and hold the (Cancel or Stop/Clear)
button on the control panel for about 5 seconds. You can find
your machine’s PIN number.

2

Press and hold the
(WPS) button on the control panel for
more than 4 seconds until the status LED stays on.
The machine starts connecting to the access point (or wireless
router).

3

You need to enter the eight-digit PIN within two minutes on
the computer that is connected to the access point (or
wireless router).
The LED blinks slowly for up to two minutes until you enter the
eight-digit PIN.
The WPS LED blinks in the order below:
a The light blinks fast on the WPS LED. The machine is
connecting to the access point (or wireless router).
b When the machine is successfully connected to the
wireless network, the WPS LED light stays on.

2. Using a network-connected machine
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Re-connecting to a network
When the wireless function is off, the machine automatically tries to
re-connect to the access point (or wireless router) with the
previously used wireless connection settings and address.

In the following cases, the machine automatically reconnects to the wireless network:
• The machine is turned off and on again.
• The access point (or wireless router) is turned off and on
again.

Canceling the connection process
To cancel the wireless network connection when the machine is
connecting to the wireless network, press and release the (Cancel
or Stop/Clear) button on the control panel. You need to wait 2
minuites to re-connect to the wireless network.

Wireless network setup

2. Using a network-connected machine

Disconnecting from a network
To disconnect the wireless network connection, press the
button on the control panel for more than two seconds.
•

•

(WPS)

When the Wi-Fi network is in idle mode: The machine is
immediately disconnected from the wireless network, and the
WPS LED is off.

1
2
3

When the Wi-Fi network is being used: While the machine
waits until the current job is finished, the light blinks fast on the
WPS LED. Then, the wireless network connection is automatically
disconnected. The WPS LED is off.

Press the
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(Menu) button on the control panel.

Press Network > OK > Wireless > OK > WLAN Settings > OK.
Press the OK to select the setup method you want.
•

Wizard: The wireless network interface card in your
machine searches for wireless networks in the area and
shows the results.

•

Custom: You can configure the wireless settings according
to your needs.

Wizard mode
16



 Using the menu button

Before starting, you will need to know the network name (SSID) of
your wireless network and the network key if it is encrypted. This
information was set when the access point (or wireless router) was
installed. If you do not know about your wireless environment,
please ask the person who set up your network.

After completing the wireless network connection, you need
to install a machine driver to print from an application (see
"Installing driver over the network" on page 17).

1

The wireless network interface card on your machine searches
for wireless networks in the area and shows the results.

2

Press Search List > OK > select a the network > OK.

3

Press WLAN Security > OK > None > OK.

You can select a network using SSID.

If you see another message, go to the next step.

Wireless network setup
4

According to the network you selected, the WLAN security
encryption type will be WEP or WPA.
•

-

5

3

Open System: Authentication is not used, and
Encryption may or may not be used, depending on the
need for data security. Enter the WEP Key after
selecting Open System.
SharedKey: Authentication is used. A device that has
a proper WEP Key can access the network. Enter the
WEP Key after selecting SharedKey.

In case of WPA, enter the WPA Key. The key length should
be between 8 and 63 characters long.

•

Ad-hoc: Allows wireless devices to communicate directly
with each other in a peer-to-peer environment. Go to step
4.

•

Infrastructure: Allows wireless devices to communicate
with each other through an access point. Go to step 5.

4

Press OK to select the method of Channel.

5

Press OK to select the method of WLAN Security.

If you select Auto, the wireless network interface card on your
machine will automatically adjust the channels.

•

None: This is used when the validation of a wireless
device’s identity and data encryption are not required for
your network. Open system is used for IEEE 802.11
authentication.

•

Static WEP: This uses the WEP (Wired Equivalent Privacy)
algorithm suggested by IEEE 802.11 standard for security.
Static WEP security mode requires a proper WEP key for
data encryption, decryption, and IEEE 802.11
authentication. Press OK to select the setup method in
Authentication

Press OK.

Custom mode

1

Enter the SSID when Edit SSID appears on the top line of the
display, the name that identifies a wireless network. SSID is
case-sensitive so you need to enter it carefully. Press OK.

2

Select the type of wireless connections.
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Press OK to select the method of Operation Mode.

In case of WEP, press the Open System or SharedKey.
-

•

2. Using a network-connected machine

-

Open System: Authentication is not used, and
encryption may or may not be used, depending on the
need for data security. Enter the WEP Key.

Wireless network setup
•

SharedKey: Authentication is used. Enter the WEP
Key after selecting SharedKey.

2. Using a network-connected machine
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WPA-PSK or WPA2-PSK: You can select WPA-PSK or
WPA2-PSK to authenticate the print server based on WPA
Pre-Shared Key. This uses a shared secret key (generally
called Pre-Shared Key passphrase), which is manually
configured on the access point and each of its clients.

c Enter the WPA Key.

6

Press OK.

Disconnect the network cable (standard or crossover). Your
machine should then start communicating wirelessly with
the network. In case of Ad-hoc mode, you can use a wireless
LAN and wired LAN simultaneously.

 Setup using Windows

Shortcut to Wireless Setting program without CD: If you
have installed the printer driver once, you can access the
Wireless Setting program without CD. From the Start menu,
select Programs or All Programs > Samsung Printers >
your printer driver name > Wireless Setting Program.

a Press OK when WPA-PSK or WPA2-PSK appears of on
the display.
b Press OK to select TKIP or AES in Encryption. If you
select WPA2-PSK, press OK to select AES or TKIP +
AES in Encryption.
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Access point via USB cable
► Items to prepare
•

Access point

•

Network-connected computer

•

Software CD that was provided with your machine

•

The machine installed with a wireless network interface

•

USB cable

► Creating the infrastructure network

1
2

Check whether the USB cable is connected to the machine.
Turn on your computer, access point, and machine.

Wireless network setup
3
4

2. Using a network-connected machine
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Insert the supplied software CD into your CD-ROM drive.
If the search has failed, you may check if the USB cable is
properly connected between the computer and machine,
and follow the instructions on the window.

Select the Wireless Setting and Installation option.

7

•

•

Install Now: If you have already set up the wireless
network, click this button to install the machine’s driver to
use the wireless network machine. If you have not set up
the wireless network, click the Wireless Setting and
Installation button to set up the wireless network before
you click this button.
Wireless Setting and Installation: Configure the wireless
network settings of your machine with a USB cable then
install the machine driver. This is only for users who have
not set up the wireless connection before.

5

Read the License Agreement, and select I accept the terms
of the License Agreement. Then, click Next.

6

The software searches the wireless network.

After searching, the window shows the wireless network
devices. Select the name (SSID) of the access point you are
using and click Next.

If you cannot find the network name you want to choose, or
if you want to set the wireless configuration manually, click
Advanced Setting.
• Enter the wireless Network Name: Enter the SSID of
access point you want (SSID is case-sensitive).
• Operation Mode: Select Infrastructure.
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to
authenticate the print server based on WPA Pre-Shared
Key. This uses a shared secret key (generally called PreShared Key pass phrase) which is manually configured on
the access point and each of its clients.

Wireless network setup
• Encryption: Select the encryption (None, WEP64,
WEP128, TKIP, AES, TKIP AES).
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• Network Key: Enter the encryption network key value.

The wireless network security window appears when the
access point has security settings.

• Confirm Network Key: Confirm the encryption network
key value.

The wireless network security window appears. The window
may differ according to its security mode: WEP, or WPA.

• WEP Key Index: If you are using WEP Encryption, select
the appropriate WEP Key Index.

• WEP
Select Open System or Shared Key for the authentication
and enter the WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.
• WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key
that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.

Wireless network setup
8

2. Using a network-connected machine

37

The window shows the wireless network settings and checks
if the settings are correct. Click Next.

-

Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

•

-

Gateway: 169.254.133.1

For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the window. If it shows Static, click
Change TCP/IP to change the assignment method to
DHCP.

•

For the Static method
If the IP address assignment method is Static, check if
Static is shown in the window. If it shows DHCP, click
Change TCP/IP to enter the IP address and other network
configuration values for the machine. Before entering the
IP address for the machine, you must know the computer’s
network configuration information. If the computer is set
to DHCP, you must contact the network administrator to
get the static IP address.

9

When the wireless network setting is completed, disconnect
the USB cable between the computer and machine. Click
Next.

10 The Wireless Network Setting Complete window appears.

Select Yes if you accept the current settings and continue the
setup procedure.
Select No if you want to return to the beginning screen.
Then, click Next.

Next when the Confirm Printer Connection window
11 Click
appears.

For example:
If the computer’s network information is as shown below:
-

IP address: 169.254.133.42

-

Subnet Mask: 255.255.0.0

Then, the machine’s network information should be as
follows:
-

IP address: 169.254.133.43

12 Select the components to be installed. Click Next.
selecting the components, you can also change the
13 After
machine name, set the machine to be shared on the network,
set the machine as the default machine, and change the port
name of each machine. Click Next.

Wireless network setup
the installation is finished, a window asking you to print
14 After
a test page appears. If you want to print a test page, click Print
a test page.
Otherwise, just click Next and go to step 16.

15 If the test page prints out correctly, click Yes.
If not, click No to reprint it.

register as a user of the machine in order to receive
16 To
information from Samsung, click On-line Registration.

2. Using a network-connected machine
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► Creating the ad hoc network in Windows

1
2
3
4

Check whether the USB cable is connected to the machine.
Turn on your computer and the wireless network machine.
Insert the supplied software CD into your CD-ROM drive.
Select the Wireless Setting and Installation option.

17 Click Finish.
Ad hoc via USB cable
If you do not have an access point (AP), you may still connect the
machine wirelessly to your computer by setting up an ad-hoc
wireless network by following the simple steps below.

•

Install Now: If you have set the wireless network, click this
button to install the machine’s driver to use the wireless
network machine. If you have not set the wireless network,
click Wireless Setting and Installation button to set the
wireless network before you click this button.

•

Wireless Setting and Installation: Configure the wireless
network settings of your machine’s with a USB cable then
install the machine driver. This only for users who have not
set up the wireless connection before.

► Items to prepare
•

Network-connected computer

•

Software CD that was provided with your machine

•

The machine installed with a wireless network interface

•

USB cable

Wireless network setup
5
6

Read the License Agreement, and select I accept the terms
of the License Agreement. Then, click Next.
The software searches the wireless network.

If the software has failed to search the network, check if the
USB cable is connected properly between the computer and
machine, and follow the instruction in the window.

7

After searching the wireless networks, a list of wireless
networks your machine has searched appears.
If you want to use the Samsung default ad hoc setting, select
the last wireless network on the list, Network Name(SSID) is
portthru and Signal is Printer Self Network.

2. Using a network-connected machine
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• Channel: Select the channel. (Auto Setting or 2412 MHz
to 2467 MHz).
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
• Encryption: Select the encryption (None, WEP64,
WEP128).
• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network
key value.
• WEP Key Index: If you are using WEP Encryption, select
the appropriate WEP Key Index.

Then, click Next.

The wireless network security window appears when the ad
hoc network has security setting.

If you want to use other ad hoc settings, select another
wireless network from the list.

The wireless network security window appears. Select Open
System or Shared Key for the authentication and click Next.

If you want to change ad hoc settings click the Advanced
Setting button.
• Enter the wireless Network Name: Enter the SSID name
you want (SSID is case-sensitive).
• Operation Mode: Select ad hoc.

• WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

Wireless network setup
8

The window showing the wireless network setting appears.
Check the settings and click Next.
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Wireless network setup
Before entering the IP address for the machine, you must
know the computer’s network configuration information. If
the computer’s network configuration is set to DHCP, the
wireless network setting should also be DHCP. Likewise, if
the computer’s network configuration is set to Static, the
wireless network setting should also be Static.
If your computer is set to DHCP and you want to use the
Static wireless network setting, you must contact the
network administrator to get the static IP address.
• For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the Wireless Network Setting Confirm
window. If it shows Static, click Change TCP/IP to change
the assignment method to Receive IP address
automatically (DHCP).
• For the Static method
If the IP address assignment method is Static, check if
Static is shown in the Wireless Network Setting Confirm
window. If it shows DHCP, click Change TCP/IP to enter
the IP address and other network configuration values for
the machine.
For example:
If the computer’s network information is as shown follows:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as
below:

2. Using a network-connected machine
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- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)
- Gateway: 169.254.133.1

9

When the wireless network settings are completed,
disconnect the USB cable between the computer and
machine. Click Next.

If the Change PC Network Setting window appears, follow
the steps in the window.
Click Next if you are finished with the computer’s wireless
network settings.
If you set the computer’s wireless network on DHCP, it will
take several minutes to receive the IP address.

10 The Wireless Network Setting Complete window appears.

Select Yes if you accept the current settings and continue the
setup procedure.
Select No if you want to return to the beginning screen.
Then, click Next.

Next when the Confirm Printer Connection window
11 Click
appears.

Wireless network setup
12
selecting the components, you can also change the
13 After
machine name, set the machine to be shared on the network,
Select the components to be installed. Click Next.

set the machine as the default machine, and change the port
name of each machine. Click Next.
the installation is finished, a window asking you to print
14 After
a test page appears. If you want to print a test page, click Print
a test page.
Otherwise, just click Next and go to step 15.

15 If the test page prints out correctly, click Yes.
If not, click No to reprint it.

16

To register as a user of the machine in order to receive
information from Samsung, click On-line Registration.

17 Click Finish.
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 Setup using Macintosh

Items to prepare
•

Access point

•

Network-connected computer

•

Software CD that was provided with your machine

•

The machine installed with a wireless network interface

•

USB cable

Access point via USB cable

1
2
3
4

Check whether the USB cable is connected to the machine.

5
6

Double-click the MAC_Installer folder.

Turn on your computer, access point, and machine.
Insert the supplied software CD into your CD-ROM drive.
Double-click the CD-ROM icon that appears on your
Macintosh desktop.

Double-click the Installer OS X icon.

Wireless network setup
7 Enter the password and click OK.
8 Click Continue.
9 Read the license agreement and click Continue.
10 Click Agree to agree to the license agreement.
11 Click Continue.
Easy Install and click Install. Easy Install is
12 Select
recommended for most users. All components necessary for
machine operations will be installed.
If you select Custom Install, you can choose which individual
operations will be installed.

13 Select the Wireless Setting and Installation option.
14 The software searches the wireless network.
If the search has failed, you may check if the USB cable is
connected between the computer and machine properly,
and follow the instructions in the window.

2. Using a network-connected machine
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searching, the window shows the wireless network
15 After
devices. Select the name (SSID) of the access point you are
using and click Next.

When you set the wireless configuration manually, click
Advanced Setting.
• Enter the wireless Network Name: Enter the SSID of the
access point you want with (SSID is case-sensitive).
• Operation Mode: Select Infrastructure.
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to
authenticate the print server based on WPA Pre-Shared
Key. This uses a shared secret key (generally called PreShared Key pass phrase) that is manually configured on
the access point and each of its clients.
• Encryption: Select the encryption. (None, WEP64,
WEP128, TKIP, AES, TKIP, AES)
• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network
key value.
• WEP Key Index: If you are using WEP Encryption, select
the appropriate WEP Key Index.

Wireless network setup
The wireless network security window appears when the
access point has security setting.

2. Using a network-connected machine

window shows the wireless network settings and check if
16 The
settings are right. Click Next.

The wireless network security window appears. The window
may differ according to its security mode: WEP or WPA.

•

• WEP
Select Open System or Shared Key for the authentication
and enter the WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

•

• WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key
that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.
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For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the window. If it shows Static, click
Change TCP/IP to change the assignment method to
DHCP.
For the Static method
If the IP address assignment method is Static, check if
Static is shown in the window. If it shows DHCP, click
Change TCP/IP to enter the IP address and other network
configuration values for the machine. Before entering the
IP address for the machine, you must know the computer’s
network configuration information. If the computer is set
to DHCP, you must contact the network administrator to
get the static IP address.
For example:
If the computer’s network information is as shown follows:
-

IP address: 169.254.133.42

-

Subnet Mask: 255.255.0.0

Then, the machine’s network information should be as
follows:
-

IP address: 169.254.133.43

Wireless network setup
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-

Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

•

-

Gateway: 169.254.133.1

► Creating the ad hoc network in Macintosh

The wireless network connects according to the network
configuration.

the wireless network settings are completed,
18 When
disconnect the USB cable between the computer and
machine.
the instructions on the screen to complete the
19 Follow
installation. After the installation is finished, click Quit or
Restart.

Ad hoc via USB cable
If you do not have an access point (AP), you may still connect the
machine wirelessly to your computer by setting up an ad hoc
wireless network by following these simple directions.

► Items to prepare
•

Network-connected computer

•

Software CD that provided with your machine

•

The machine installed with a wireless network interface

45

USB cable

1
2
3
4

Check whether the USB cable is connected to the machine.
Turn on your computer and machine.
Insert the supplied software CD into your CD-ROM drive.
Double-click the CD-ROM icon that appears on your
Macintosh desktop.

5 Double-click the MAC_Installer folder.
6 Double-click the Installer OS X icon.
7 Enter the password and click OK.
8 Click Continue.
9 Read the license agreement and click Continue.
10 Click Agree to agree to the license agreement.

Wireless network setup
Easy Install and click Install. Easy Install is
11 Select
recommended for most users. All components necessary for
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machine operations will be installed.

If you want to change ad hoc settings click the Advanced
Setting button.

If you select Custom Install, you can choose individual
operations will be installed.

• Enter the wireless Network Name: Enter the SSID name
you want (SSID is case-sensitive).
• Operation Mode: Select ad hoc.

12 Click Wireless Setting and Installation.
13 The software searches the wireless network devices.
If the search has failed, check if the USB cable is connected
between the computer and machine properly, and follow
the instructions in the window.

searching the wireless networks, a list of wireless
14 After
networks your machine has searched appears.
If you want to use the Samsung default ad hoc setting, select
the last wireless network on the list, which Network
Name(SSID) is portthru and Signal is Printer Self Network.
Then, click Next.
If you want to use other ad hoc settings, select another
wireless network from the list.

• Channel: Select the channel (Auto Setting or 2412 MHz
to 2467 MHz).
• Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
• Encryption: Select the encryption (None, WEP64,
WEP128).
• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network
key value.
• WEP Key Index: If you are using WEP Encryption, select
the appropriate WEP Key Index.

Wireless network setup
The wireless network security window appears when the ad
hoc network has security setting.
The wireless network security window appears. Select Open
System or Shared Key for the authentication and click Next.
• WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

window showing the wireless network settings appears.
15 The
Check the settings and click Next.
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Wireless network setup
Before entering the IP address for the machine, you must
know the computer’s network configuration information. If
the computer’s network configuration is set to DHCP, the
wireless network setting should also be DHCP. Likewise, if
the computer’s network configuration is set to Static, the
wireless network setting should also be Static.
If your computer is set to DHCP and you want to use Static
wireless network setting, you must contact the network
administrator to get the static IP address.
• For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the Wireless Network Setting Confirm
window. If it shows Static, click Change TCP/IP to change
the assignment method to Receive IP address
automatically (DHCP).
• For the Static method
If the IP address assignment method is Static, check if
Static is shown in the Wireless Network Setting Confirm
window. If it shows DHCP, click Change TCP/IP to enter
the IP address and other network configuration values for
the machine.
For example:
If the computer’s network information is as shown follows:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as
below:
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- IP address: 169.254.133.43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)
- Gateway: 169.254.133.1

wireless network connects according to the network
16 The
configuration.
the wireless network setting is completed, disconnect
17 When
the USB cable between the computer and machine.
the instructions on the screen to complete the
18 Follow
installation. After the installation is finished, click Quit or
Restart.
19



 Using a network cable

Your machine is a network compatible machine. To enable your
machine to work with your network, you will need to perform some
configuration procedures.

Wireless network setup
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IP setting using SetIP Program (Windows)
• After completing the wireless network connection, you
need to install a machine driver to print from an
application (See "Installing driver over the network" on
page 17).
• See your network administrator, or the person that set up
your wireless network, for information about your
network configuration.

This program is used to manually set the network IP address of your
machine using its MAC address to communicate with the machine.
The MAC address is the hardware serial number of the network
interface and can be found in the Network Configuration Report.
See "Setting IP address" on page 13.

Configuring the machine’s wireless network
Items to prepare
•

Access point

•

Network-connected computer

•

Software CD that was provided with your machine

•

The machine installed with a wireless network interface

•

Network cable

Before starting you will need to know the network name (SSID) of
your wireless network and the network key if it is encrypted. This
information was set when the access point (or wireless router) was
installed. If you do not know about your wireless environment,
please ask the person who set up your network.
To configure wireless parameters, you can use SyncThru™ Web
Service.

Printing a network configuration report

Using SyncThru™ Web Service

You can identify the network settings of your machine by printing a
network configuration report.

Before starting wireless parameter configuration, check the cable
connection status.

See "Printing a network configuration report" on page 13.

Wireless network setup
1

Check whether or not the network cable is connected to the
machine. If not, connect the machine with a standard network
cable.

2

Start a web browser such as Internet Explorer, Safari or Firefox
and enter your machine’s new IP address in the browser
window.
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Wizard will help you setup the wireless network
configuration. However, if you want to set the wireless
network directly, select Custom.

7

Select the one Network Name(SSID) in the list.

For example,

•

SSID: SSID (Service Set Identifier) is a name that identifies a
wireless network, access points, and wireless devices
attempting to connect to a specific wireless network must
use the same SSID. The SSID is case-sensitive.

3

Click Login on the upper right of the SyncThru™ Web Service
website.

•

4

Type in the ID and Password then click Login.

Operation Mode: Operation Mode refers to the type of
wireless connections (See "Wireless network name and
network key" on page 27).

5
6

•

ID: admin

•

Password: sec00000

-

Ad-hoc: Allows wireless devices to communicate
directly with each other in a peer-to-peer environment.

-

Infrastructure: Allows wireless devices to
communicate with each other through an access point.

When the SyncThru™ Web Service window opens, click
Network Settings.
Click Wireless > Wizard.

If your network’s Operation Mode is Infrastructure, select
the SSID of the access point. If the Operation Mode is Adhoc, select the machine’s SSID. Note that “portthru” is the
default SSID of your machine.

Wireless network setup
8
9

2. Using a network-connected machine

Click Next.
If the wireless security setting window appears, enter the
registered password (network key) and click Next.
The confirmation window appears, please check your wireless
setup. If the setup is right, click Apply.

Disconnect the network cable (standard or network). Your
machine should then start communicating wirelessly with
the network. In case of Ad-hoc mode, you can use a wireless
LAN and wired LAN simultaneously.
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3

Click Login on the upper right of the SyncThru™ Web Service
website.

4

Type in the ID and Password then click Login.
•

ID: admin

•

Password: sec00000

5

When the SyncThru™ Web Service window opens, click
Network Settings.

6

Click Wireless > Custom.
You can also turn the Wi-Fi network on/off.

20

21



1

 Turning the Wi-Fi network on/off
Check whether the network cable is connected to the
machine. If not, connect the machine with a standard network
cable.



 Troubleshooting

Problems during setup or driver installation
► Printers Not Found

2

Start a web browser such as Internet Explorer, Safari or Firefox
and enter your machine’s new IP address in the browser
window.
For example,

•

Your machine may not be turned on. Turn on your computer and
the machine.

•

USB cable is not connected between your computer and
machine. Connect machine to your computer using the USB
cable.

Wireless network setup
•

The machine does not support a wireless network. Check the
machine's user's guide included on the software CD supplied
with your machine and prepare a wireless network machine.

► Connecting Failure - Not Found SSID
•

The machine is unable to search the network name (SSID) you
have selected or entered. Check the network name (SSID) on your
access point and try connecting again.

•

Your access point is not turned on. Turn on your access point.
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► Connecting Failure - Invalid Security
•

You configured security incorrectly. Check the configured
security on your access point and machine.

► Connecting Failure - General Connection Error
•

Your computer is not receiving a signal from your machine.
Check the USB cable and your machine’s power.

► Connecting Failure - Connected Wired Network
•

Your machine is connected with a wired network cable. Remove
the wired network cable from your machine.

► PC Connection Error
•

The configured network address is unable to connect between
your computer and machine.
-

For a DHCP network environment
The receives the IP address automatically (DHCP) when
computer is configured to DHCP.

-

For a Static network environment
The machine uses the static address when the computer is
configured to static address.
For example:
If the computer’s network information is as shown below:
▪

IP address: 169.254.133.42

Wireless network setup
▪

Subnet Mask: 255.255.0.0
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•

Then, the machine’s network information should be as below:
▪

IP address: 169.254.133.43

▪

Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

▪

Gateway: 169.254.133.1
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Check whether firewall software (V3 or Norton) is blocking the
communication.
If the computer and the machine are connected on the same
network and it cannot be found when searching, firewall
software might be blocking the communication. Refer to the
user's guide for the software to turn it off and try searching for the
machine again.

•

Check whether the machine's IP address is allocated correctly.
You can check the IP address by printing the network
configuration report.

If problems occur while using the machine on a network, check the
following:

•

Check whether the access point (or wireless router) has a
configured security (password). If it has a password, refer to the
access point (or wireless router) administrator.

For information on the access point (or wireless router), refer
to its own user's guide.

•

Check the machine's IP address. Reinstall the machine driver and
change the settings to connect to the machine on the network.
Due to the characteristics of DHCP, the allocated IP address could
change if the machine is not used for a long time or if the access
point has been reset.

•

Check the wireless environment. You might not be able to
connect to the network in the infrastructure environment where
you need to type in a user's information before connecting to
access point (or wireless router).

•

This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other
wireless communication types (e.g., Bluetooth) are not
supported.

Other problems

•

Your computer, access point (or wireless router), or machine may
not be turned on.

•

Check the wireless reception around the machine. If the router is
far from the machine or there is an obstacle, you might have
difficulty receiving the signal.

•

Cycle the power for the access point (or wireless router), machine,
and computer. Sometimes cycling the power can recover
network communication.

Wireless network setup
•

When using the ad hoc mode, in operating systems such as
Windows Vista, you might need to set the wireless connection
setting every time you use the wireless machine.

•

You cannot use Infrastructure mode and Ad hoc mode at the
same time for Samsung wireless network machines.

•

The machine is within the range of the wireless network.

•

The machine is located away from obstacles that could block the
wireless signal.
Remove any large metal objects between the access point (or
wireless router) and the machine.
Make sure the machine and wireless access point (or wireless
router) are not separated by poles, walls, or support columns
containing metal or concrete.

•

The machine is located away from other electronic devices that
may interfere with the wireless signal.
Many devices can interfere with the wireless signal, including a
microwave oven and some Bluetooth devices.

2. Using a network-connected machine

54

3. Useful setting menus
This chapter explains how to browse the current status of your machine, and the
method of setting for advanced machine setup.

• Information

56

• Layout

57

• Paper

58

• Graphic

59

• System setup

60

• Emulation

63

• Network

64

• Admin setup

65



The control panel provides access to various menus to set up the
machine or use the machine’s functions. These menus can be accessed
by pressing (Menu).
• An asterisk (*) appears next to the currently selected menu.
• Some menus may not appear on the display depending on options or
models. If so, it is not applicable to your machine.
• For models that do not have the display screen on the control panel,
this feature is not applicable.
• Some menu names may differ from your machine depending on its
options or the models.

Information
Item

3. Useful setting menus

Description

Menu Map

Prints the menu map which shows the layout
and current settings of this machine.

Configuration

Prints a report on the machine's overall
configuration.

Supplies Info.

Prints supplies’ information page.

Demo Page

Prints the demo page to check whether your
machine is printing properly or not.

PCL Font (PCL Font Prints the PCL font list.
List)
PS Font (PS Font
List)

Prints the PS font list.

EPSON Font
(EPSON Font List)

Prints the EPSON font list.

KSC5843 Font List

Prints the KS font list.

KSC5895 List

Prints the KS5895 font list.

KSSM Font List

Prints the KSSM font list.

Stored Job List

Prints jobs currently stored in the optional
memory or on a hard disk (HDD).

Usage Counter

Prints a usage page. The usage page contains
the total number of pages printed.

Item
Completed Job
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Description
Prints list of completed jobs.

This is used only available when Job
Accounting is enabled from the SyncThru™
Accounting Report
Web Admin Service. You can print a report of
printout counts for each user.

Layout
Item
Orientation

3. Useful setting menus

Description
Selects the direction in which information is
printed on a page.
• Simplex Margin: Sets the margin for onesided printing.

Item
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Description
Sets the paper margins for emulation print page.

Emulation Mar.
(Emulation
Margin)

• Duplex: Sets the margin for double-sided
printing.

• Top Margin: Sets the top margin, from 0.0 to
250 mm.
• Left Margin: Sets the left margin, from 0.0 to
164 mm.
To print on both sides of the paper, choose the
binding edge.

Common Margin • Binding: When printing on both sides of the
paper, side A's margin closest to the binding
will be the same as side B's margin closest to
the binding. Likewise, the sides' margins
farthest from the binding will be the same.

• Off: Disables this option.
• Long Edge: This binding is the conventional
layout used in bookbinding.

Sets the paper margins in multi-purpose tray.
MP Tray

• Simplex: Sets the margin for one-sided
printing.
• Duplex: Sets the margins for double-sided
printing.

Duplex Margin
• Short Edge: This binding is the conventional
layout used in calendars.

Sets the paper margins in trays.
Tray X

• Simplex: Sets the margin for one-sided
printing.
• Duplex: Sets the margins for double-sided
printing.

Landscape
Selects the location of the staple.
Stapling Position

Paper
Item
Copies
MP Tray /
[Tray<x>]
Paper Source

Tray Chaining
(Auto Tray
Switch)

3. Useful setting menus

Description
Selects the number of copies.
• Paper Size: Selects the default paper size.
• Paper Type: Selects the paper type currently
loaded in the tray.
Sets from which tray to use paper.
When you select any other value except Auto
from Paper Source and the selected tray is
empty, you can set the machine to automatically
print from other trays.

If you select Auto from Paper Source,
this message does not appear.

Tray Confirm

Activates the tray confirmation message. If you
open and close a tray, a window asking you
whether to set the paper size and type for the
tray just opened appears.
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Graphic
Item
Resolution
Darken Text
(Clear Text)
Darkness

3. Useful setting menus

Description
Specifies the number of dots printed per inch
(dpi). The higher the setting, the sharper printed
characters and graphics.
Prints text darker than on a normal document.
Lightens or darkens the print on the page. The
Normal setting usually produces the best result.
Use the Light toner density setting to save toner.
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System setup
Item

3. Useful setting menus

Description

Date & Time

Sets the date and time.

Clock Mode

Selects the format for displaying time between
12 hr and 24 hr.

Form Menu

Item

Description
Sets how long the machine waits before going to
power save mode.

Power Save

• Off: Prints in normal mode.

When the machine does not receive data for an
extended period of time, power consumption is
automatically lowered.

• Single Form: Prints all page using the first
form.

You can set the condition to wake up from
power-save mode. Set the item on.

• Double Form: Prints the front page using the
first form and the back page using the second
form.

• Button Press: When you press any button
except power button, the machine wake up
from the power save mode.

Wakeup Event

Select Form

Form overlay is images stored on the printer’s
hard disk as a special file format that can be
printed in layers on any document.

• Printer: When you open or close the paper
tray, the machine wake up from the power
save mode.

HDD Spooling

When On, stores documents on the hard disk
drive (HDD) for network printing.

Language

Sets the language of the text that appears on the
control panel display.

Determine whether or not the machine
continues printing when it detects the paper
does not match the paper settings.

Default Paper
Size
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Auto Continue

You can set the default paper size to use.

• Off: If a paper mismatch occurs, the machine
waits until you insert the correct paper.
• On: If a paper mismatch occurs, an error
message will display. The machine waits for
about 30 second, then automatically clear the
message and continue printing.

Altitude Adj.

Optimize print quality according to the
machine’s altitude.

System setup
Item
Auto CR

Job Timeout

Multi-Bin

3. Useful setting menus

Description

Item

Allows you to append the required carriage
return to each line feed, which is useful for Unix
or DOS users.

Description
• Clean Drum: Cleans the OPC drum of the
cartridge by printing a sheet.
• Clean Fuser: Cleans the fuser by printing a
sheet.

When there is no input for a certain period of
time, the machine cancels the current job. You
can set the amount of time the machine will wait
before canceling the job.

• CLR Empty Msg.: This option appears only
when toner cartridge is empty.
• Supplies Info.: Allows you to check how
many pages are printed and how much toner
is left in the cartridge.

• Mode: Selects the mult-bin mode you want to
use.
• Default Bin: Selects the bin to use as a default.
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Maintenance

• TonerLow Alert: If toner in the cartridge has
run out, a message informing the user to
change the toner cartridge appears. You can
set the option for this message to appear or
not.
• Paper Stacking: If you use a machine in a
humid area, or you are using the damp print
media caused by a high humidity, the printouts on the output tray may be curled and
may not be stacked properly. In this case, you
can set the machine to use this function to let
print-outs stacked firmly. But, using this
function will make the print speed slow.

Import Setting

Imports data stored on a USB memory stick to
the machine.

System setup
Item

3. Useful setting menus

Description

Export Setting

Exports data stored on a USB memory stick to the
machine.

Toner Save

Activating this mode extends the life of your
toner cartridge and reduces your cost per page
beyond what one would experience in the
normal mode, but it reduces print quality.

Quiet Mode

You can reduce the printing noise by turning this
menu on. However, the printing speed and
quality may be declined.
Allows you to save print resources and enables
eco-friendly printing.
• Default Mode: Select whether to turn the Eco
mode on or off.

Eco Setup

Onforce: Sets the Eco mode on with
password. If a user wants to turn the
Eco mode on/off, the user needs to
enter the password.
• Change Template: Selects the eco template
set from the SyncThru™ Web Service.

Clear Setting

Restores the machine’s factory default settings.
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Emulation
Item

3. Useful setting menus

Description

Emulation Type

The machine language defines how the
computer communicates with the machine.

Setup

Sets the detailed settings for the selected
emulation type.
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Network
Option

3. Useful setting menus

Description
Selects the appropriate protocol and configure
parameters to use the network environment.

TCP/IP (IPv4)

There are lots of parameters to be set.
If you are not sure, leave as is, or
consult the network administrator.

TCP/IP (IPv6)

Selects this option to use the network
environment through IPv6 (see "IPv6
configuration" on page 24).

Ethernet Speed

Configure the network transmission speed.

802.1x

You can selects the user authentication for
network communication. For detailed
information consult the network administrator.

Wireless

Selects this option to use the wireless network.

Clear Setting

Reverts the network settings to the default
values.

Network Conf.
(Network
Configuration)

This list shows information on your machine’s
network connection and configuration.

Net. Activate

You can sets whether to use Ethernet on or off.

Option
Http Activate

Description
You can sets whether to use SyncThru™ Web
Service or not.
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Admin setup
Item

3. Useful setting menus

Description

Password
Protect

Sets the password to access the Admin Setup
menu. Select On to use this option and enter the
password.

Change
Password

Changes the machine’s password for accessing the
Admin Setup.
• Clean Fuser: Cleans the fuser by printing a
sheet. The printed sheet has toner debris on it.
• CLR Empty Msg.: Prevents the TonerLow Alert
message from appearing on the display.
• Supplies Info.: Allows you to check how many
pages are printed and how much toner is left in
the cartridge.

Maintenance

• TonerLow Alert: If toner in the cartridge has run
out, a message informing the user to change the
toner cartridge appears. You can set the option
for this message to appear or not.
• Ram Disk: Enables/disables RAM disk to manage
jobs. Depending on the installed optional
memory size, you can set the RAM disk size to
between 32 and 64 MB. This option does not
appear if you have installed hard disk drive
(HDD).
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4. Special features
This chapter explains special printing features.

• Altitude adjustment

67

• Changing the font setting

68

• Changing the default print settings

69

• Setting your machine as a default machine

70

• Using advanced print features

71

• Using Direct Printing Utility (Windows only)

79

• Using memory/hard drive features

81

• Macintosh printing

83

• Linux printing

85

• Unix printing

88



The procedures in this chapter are mainly based on Windows 7.

Altitude adjustment

4. Special features

Print quality is affected by atmospheric pressure, which is
determined by the height of the machine above sea level. The
following information will guide you on how to set your machine for
the best print quality.
Before you set the altitude value, determine the altitude where you
are.
4,000 m
(13,123 ft)

1
3,000 m
(9,842 ft)

2
2,000 m
(6,561 ft)

3

1,000 m
(3,280 ft)

4
0

1
2
3
4

High 3
High 2
High 1
Normal

•

For Windows user, see "Device Settings" on page 97.

•

For Macintosh, Linux, or Unix OS user, see "Using Smart Panel
(Macintosh and Linux only)" on page 99.
• If your machine is connected to the network, you can set
the altitude via SyncThru™ Web Service.
• You can also set the altitude in System Setup option on
the machine’s display.
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Changing the font setting
Your machine has preset the font for your region or country.
If you want to change the font or set the font for special condition,
such as the DOS environment, you can change the font setting from
Device Settings or Emulation section.
•

For Windows user, see "Device Settings" on page 97.

•

For Macintosh, Linux, or Unix OS user, see "Using Smart Panel
(Macintosh and Linux only)" on page 99.
• If your machine is connected to the network, you can set
the font setting via SyncThru™ Web Service.
• You can also change the font setting in Emulation option
on the machine’s display.
• The following information shows the proper font list for
corresponding languages.
- Russian: CP866, ISO 8859/5 Latin Cyrillic
- Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
- Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
- Arabic & Farsi: HP Arabic-8, Windows Arabic, Code
Page 864, Farsi, ISO 8859/6 Latin Arabic
- OCR: OCR-A, OCR-B

4. Special features
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Changing the default print settings
1
2

3
4

69

Click the Windows Start menu.
For Windows Server 2000, select Settings > Printers.
•

For Windows XP/Server 2003, select Printer and Faxes.

•

For Windows Server 2008/Vista, select Control Panel >
Hardware and Sound > Printers.

•

For Windows 7, select Control Panel > Devices and
Printers.

•

For Windows Server 2008 R2, select Control Panel >
Hardware > Devices and Printers.

Right-click on your machine.
For Windows XP/Server 2003/Server 2008/Vista, select
Printing Preferences.
For Windows 7 or Windows Server 2008 R2, from context
menus, select Printing preferences.

If Printing preferences has a ?, you can select other printer
drivers connected to the selected printer.

5
6

4. Special features

Change the settings on each tab.
Click OK.

If you want to change the settings for each print job, change
it in Printing Preferences.

Setting your machine as a default machine
1
2

3
4

Click the Windows Start menu.
For Windows Server 2000, select Settings > Printers.
•

For Windows XP/Server 2003, select Printer and Faxes.

•

For Windows Server 2008/Vista, select Control Panel >
Hardware and Sound > Printers.

•

For Windows 7, select Control Panel > Devices and
Printers.

•

For Windows Server 2008 R2, select Control Panel >
Hardware > Devices and Printers.

Select your machine.
Right-click your machine and select Set as Default Printer.

For Windows 7 or Windows Server 2008 R2, if Set as default
printer has a ?, you can select other printer drivers
connected to the selected printer.

4. Special features
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Using advanced print features
XPS printer driver: used to print XPS file format.

4. Special features

1

Check the Print to file box in the Print window.

2
3

Click Print.
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• The XPS printer driver can be installed only on Windows
Vista OS or higher.
• You can install the XPS printer driver when you insert the
software CD into your CD-ROM drive. When the
installation window appears, select Advanced
Installation > Custom Installation. You can select the
XPS printer driver in the Select Software and Utilities to
Install window.
• Install optional memory when an XPS job does not print
because the printer is out of memory.

1

Printing to a file (PRN)
You will sometimes need to save the print data as a file.

Type in the destination path and the file name, and then click
OK.
For example, c:\Temp\file name.

If you type in only the file name, the file is automatically
saved in My Documents, Documents and Settings, or
Users. The saved folder may differ, depending on your
operating system or the application you are using.

Using advanced print features

4. Special features
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2

Understanding special printer features
You can use advanced printing features when using your machine.
To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window
to change the print settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.
Item

Description

Multiple Pages per Side Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will
be reduced in size and arranged in the order you specify. You can print up to 16 pages on one sheet.

Poster Printing

Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose
of pasting the sheets together to form one poster-size document.
Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the
upper right of Basic tab to make it easier to paste the sheets together.

Using advanced print features
Item

4. Special features
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Description
Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half
after printing to produce a booklet.

Booklet Printing
8

9

If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media.

The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under
the Paper tab to see what paper sizes are available.
If you select an unavailable paper size, this option can be automatically canceled. Select only available
paper (paper without or mark).
Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented.
• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper

Double-sided Printing

• If your machine does not have a duplex unit, you should complete the printing job manually. The
machine prints every other page of the document first. After that, a message appears on your computer.
• Skip Blank Pages feature does not work when you select the duplex option.

Using advanced print features
Item
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Description
• Printer Default: If you select this option, this feature is determined by the settings you have selected on the
control panel of the machine. This option is available only when you use the PCL/XPS printer driver.
• None: Disables this feature.
• Long Edge: This option is the conventional layout used in bookbinding.

Double-sided Printing
(Option)
• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing.
Paper Options

Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which
to enlarge or decrease the document.

Watermark

The watermark option allows you to print text over an existing document. For example, you use it when you want to
have large gray letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a
document.

Using advanced print features
Item
Watermark
(Creating a watermark)

Watermark
(Editing a watermark)

Watermark
(Deleting a watermark)
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Description
a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box.
You can enter up to 256 characters. The message displays in the preview window.
a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and
options.
d Click Update to save the changes.
e Click OK or Print until you exit the Print window.
a
b
c
d

To change the print settings from your software application, access Printing Preferences.
Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
Select the watermark you want to delete from the Current Watermarks list and click Delete.
Click OK or Print until you exit the Print window.
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Description
This option is available only when you use the PCL printer driver.

Overlay

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be
printed on any document. Overlays are often used to take the place of letterhead paper. Rather than using preprinted
letterhead, you can create an overlay containing exactly the same information that is currently on your letterhead. To
print a letter with your company’s letterhead, you do not need to load preprinted letterhead paper in the machine:
just print the letterhead overlay on your document.
To use a page overlay, you must create a new page overlay containing your logo or image.
• The overlay document size must be the same as the document you print with the overlay. Do not create
an overlay with a watermark.
• The resolution of the overlay document must be the same as that of the document you will print with
the overlay.

Overlay
(Creating a new page
overlay)

a
b
c
d

To save the document as an overlay, access Printing Preferences.
Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
In the Edit Overlay window, click Create.
In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if
necessary (The default is C:\Formover).
e Click Save. The name appears on the Overlay List.
f Click OK or Print until you exit the Print window.
The file is not printed. Instead, it is stored on your computer hard disk drive.

Using advanced print features
Item
Overlay
(Using a page overlay)

Overlay
(Deleting a page
overlay)
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Description
a Click the Advanced tab.
b Select the desired overlay from the Text drop-down list.
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load.
Select the overlay file you want to use.
If you have stored the overlay file you want to use in an external source, you can also load the file when you access
the Open window.
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the
overlay from the Overlay List box.
d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears
each time you submit a document for printing, asking you to confirm printing an overlay on your document.
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document.
e Click OK or Print until you exit the Print window.
a
b
c
d
e
f

In the Printing Preferences window, click the Advanced tab.
Select Edit in the Text drop down list.
Select the overlay you want to delete from the Overlay List box.
Click Delete.
When a confirming message window appears, click Yes.
Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.
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4. Special features

78

Description
• This feature is available only if you have installed the optional hard disk or set the Ram Disk. To set the
Ram Disk, you must enable it from SyncThru™ Web Service Settings > Machine Settings > Ram Disk.
• Some menus may not appear on the display depending on options or models. If so, it is not applicable
to your machine.
• You can see the print job list you set in the printer driver's Print Mode in the Job Management menu
using the control panel (see "From the control panel" on page 81).

Print Mode

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the
memory.
- Normal: This mode prints without storing your document in the optional memory.
- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print
the rest of the copies later.
- Confidential: This mode is used for printing confidential documents. You need to enter a password to print.
- Store: Select this setting to save a document in the hard disk without printing.
- Store and Print: This mode is used when printing and storing document at the same time.
- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer
spools the document into the hard disk and then prints it from the hard disk queue, decreasing the computer’s
work load.
- Print Schedule: Select this setting to print the document at a specified time.
• User ID: This option is used when you need to find a saved file using the control panel.
• Job Name: This option is used when you need to find a saved file using the control panel.

Using Direct Printing Utility (Windows only)
3
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4

What is Direct Printing Utility?
Direct Printing Utility is a program that sends PDF files directly to
your machine to print without having to opening the file.
To install this program, select Advanced Installation > Custom
Installation and put a check mark in this program when you install
the printer driver.

Printing
There are several ways you can print using the Direct Printing Utility.

1

From the Start menu select Programs or All Programs >
Samsung Printers > Direct Printing Utility > Direct Printing
Utility.
The Direct Printing Utility window appears.

• For some models, a hard disk drive (HDD) should be
installed or memory inserted to properly run utilities.
Otherwise, they should be installed.
• You cannot print PDF files that are restricted. Deactivate
the printing restriction feature and retry printing.
• You cannot print PDF files that are restricted by a
password. Deactivate the password feature, and retry
printing.
• Whether or not a PDF file can be printed using the Direct
Printing Utility program depends on how the PDF file was
created.
• The Direct Printing Utility program supports PDF version
1.7 and below. For higher versions, you must open the file
to print it.

2

Select your machine from the Select Printer drop-down list
and click Browse.

3

Select the file you wish to print and click Open.

4
5

Customize the machine settings for your needs.

The file is added in the Select Files section.

Click Print. The selected PDF file is sent to the machine.

Using Direct Printing Utility (Windows only)
5

Using the right-click menu

1

Right-click on the PDF file to print and select Direct Printing.

2
3
4

Select the machine to use.

The Direct Printing Utility window appears with the PDF file is
added.

Customize the machine settings.
Click Print. The selected PDF file is sent to the machine.
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Using memory/hard drive features
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7

From the control panel

Some menus may not appear on the display depending on
options or models. If so, it is not applicable to your machine.

If your machine has optional memory or an optional hard drive, you
can use these features from the Job Management menu.

6

From the printer driver
After installing the optional memory, you can use advanced printing
features, such as proofing a job and specifying of printing a private
job in the Print window. Select Properties or Preference, and
configure the printing mode.

•

Active Job: All of the print jobs waiting to be printed are listed in
the active job queue in the order you sent them to the printer.
You can delete a job from the queue before printing, or promote
a job to print sooner.

•

File Policy: You can choose the file policy for generating file
name before you proceed with the job through optional
memory. If the optional memory already has the same name
when you entered a new file name, you can rename or overwrite
it.

•

Stored Job: You can print or delete a stored job.

•

Held Job Timeout: The machine can automatically delete a
stored job after a certain period of time. You can set the time the
machine will wait before deleting the stored job.

•

ImageOverwrite: Image Overwrite is a security measure for
customers who are concerned about unauthorized access and
duplication of classified or private document.

Using memory/hard drive features
After installing the hard drive, you can also print the
predefined document templates from the Form Menu.
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Macintosh printing
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9

Changing printer settings

Some features may not be available depending on models or
options. It means that the features are not supported.

You can use advanced printing features when using your machine.
8

Printing a document
When you print with a Macintosh, you need to check the printer
driver settings in each application you use. Follow the steps below to
print from a Macintosh:

1
2

Open the document to print.

3

Choose your paper size, orientation, scaling, other options,
and make sure that your machine is selected. Click OK.

Open the File menu and click Page Setup (Document Setup
in some applications).

4
5

Open the File menu and click Print.

6

Click Print.

Choose the number of copies and indicate which pages to
print.

Open an application and select Print from the File menu. The
machine name, which appears in the printer properties window,
may differ depending on the machine in use. Except for the name,
the composition of the printer properties window is similar to the
following.
10

Printing multiple pages on one sheet
You can print more than one page on a single sheet of paper. This
feature provides a cost-effective way to print draft copies.

1
2

Open an application, and select Print from the File menu.

3

Select the other options to use.

Select Layout from the drop-down list under Orientation. In
the Pages per Sheet drop-down list, select the number of
pages you want to print on one sheet of paper.

Macintosh printing
4
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5

Click Print.
The machine prints the selected number of pages to print on
one sheet of paper.
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Select the other options to use.
Click Print and the machine prints on both sides of the paper.

11

If you print more than 2 copies, the first copy and the second
copy might print on the same sheet of paper. Avoid printing
on both sides of paper when you are printing more than 1
copy.

Printing on both sides of the paper

Some features may not be available depending on models or
options. It means that the features are not supported.
12

Using help
Before printing in the duplex mode, decide on which edge you will
be binding your finished document. The binding options are, as
follows:
•

Long-Edge Binding: This option is the conventional layout used
in book binding.

•

Short-Edge Binding: This option is the type often used with
calendars.

1

From your Macintosh application, select Print from the File
menu.

2
3

Select Layout from the drop-down list under Orientation.
Select a binding orientation from the Two-Sided option.

Click the question mark on the bottom-left corner of the window and
click on the topic you want to know about. A pop-up window
appears with information about that option's feature, which is
provided from the driver.

Linux printing
Some features may not be available depending on models or
options. It means that the features are not supported.

4. Special features
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Change the print job properties using the following four tabs
displayed at the top of the window.
•

13

Printing from applications

General: Changes the paper size, the paper type, and the
orientation of the documents. It enables the duplex
feature, adds start and end banners, and changes the
number of pages per sheet.

Automatic/manual duplex printing may not be available
depending on models. You can alternatively use the lpr
printing system or other applications for odd-even printing.

There are a lot of Linux applications that allow you to print using
Common UNIX Printing System (CUPS). You can print on your
machine from any such application.

1
2
3
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•

Text: Specifies the page margins and set the text options,
such as spacing or columns.

Select Print directly using lpr.

•

In the LPR GUI window, select the model name of your
machine from the printer list and click Properties.

Graphics: Sets image options that are used when printing
image files, such as color options, image size, or image
position.

•

Advanced: Sets the print resolution, paper source, and
destination.

Open an application, and select Print from the File menu

5

Click Apply to apply the changes and close the Properties
window.

6

Click OK in the LPR GUI window to start printing.

Linux printing
7

The Printing window appears, allowing you to monitor the
status of your print job.
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15

Configuring Printer Properties

To abort the current job, click Cancel.
14

Printing files
You can print many different types of files on your machine using the
standard CUPS, directly from the command line interface. The CUPS
lpr utility allows you to do that, but the driver’s package replaces the
standard lpr tool by a much more user-friendly LPR GUI program.

Using the Printer Properties window provided by the Printers
configuration, you can change the various properties for your
machine as a printer.

1

Open the Unified Driver Configurator.

2

Select your machine on the available printers list and click
Properties.

3

The Printer Properties window appears.

To print any document file:

1

Enter lpr <file_name> from the Linux shell command line and
press Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to
print window appears first. Just select any files you want to
print and click Open.

2

In the LPR GUI window, select your machine from the list, and
change the print job properties.

3

Click OK to start printing.

If necessary, switch to Printers configuration.

The following five tabs display at the top of the window:
•

General: Allows you to change the printer location and
name. The name entered in this tab displays on the printer
list in Printers configuration.

•

Connection: Allows you to view or select another port. If
you change the machine port from USB to parallel or vice
versa while in use, you must re-configure the machine port
in this tab.

•

Driver: Allows you to view or select another machine
driver. By clicking Options, you can set the default device
options.

•

Jobs: Shows the list of print jobs. Click Cancel job to cancel the selected job and select the Show

completed jobs check box to see previous jobs on the job
list.
•

4

Classes: Shows the class that your machine is in. Click Add
to Class to add your machine to a specific class or click
Remove from Class to remove the machine from the
selected class.

Click OK to apply the changes and close the Printer
Properties window.
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Unix printing

4. Special features
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To take advantage of the printer features provided by your
printer driver, press Properties (see "Changing printer
settings" on page 83).

Some features may not be available depending on models or
options. It means that the features are not supported.

5

Press OK to start the print job.

16

17

Proceeding the print job
After installing the printer, choose any of the image, text, PS or HPGL
files to print.

1

Execute “printui <file_name_to_print>” command.

Changing the machine settings
The UNIX printer driver Print Job Manager in which the user can
select various print options in printer Properties.
The following hot keys may also be used: “H” for Help, “O” for OK, “A”
for Apply, and “C” for Cancel.

For example, if you are printing “document1”
printui document1

General tab

This will open the UNIX Printer Driver Print Job Manager in
which the user can select various print options.

•

Paper Size: Set the paper size as A4, Letter, or other paper sizes,
according to your requirements.

2
3

Select a printer that has been already added.

•

Paper Type: Choose the type of the paper. Options available in
the list box are Printer Default, Plain, and Thick.

Select the printing options from the window such as Page
Selection.

•

Paper Source: Select from which tray the paper is used. By
default, it is Auto Selection.

4

Select how many copies are needed in Number of Copies.

Unix printing
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•

Orientation: Select the direction in which information is printed
on a page.

HPGL/2 tab

•

Duplex: Print on both sides of paper to save paper.

•

Use only black pen: To print all graphics in black.

•

Fit plot to page: Fit the entire graphic into a single page.

•

Pen Width: Change value to increase the thickness of pen lines.
By default, it is 1000.

Automatic/manual duplex printing may not be available
depending on models. You can alternatively use the lpr
printing system or other applications for odd-even printing.

Margins tab
•

Multiple pages: Print several pages on one side of the paper.

•

Page Border: Choose any of the border styles (e.g., Single-line
hairline, Double-line hairline)

Image tab
In this tab, you can change the brightness, resolution, or image
position of your document.

Text tab
Set the character margin, line space, or the columns of the actual
print output.

•

Use Margins: Set the margins for the document. By default,
margins are not enabled. The user can change the margin
settings by changing the values in the respective fields. Set by
default, these values depend on the page size selected.

•

Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings tab
Select various options in the JCL and General frames to customize
various settings. These options are specific to the printer and depend
on the PPD file.

5. Maintenance
This chapter introduces management tools provided to help you make full use
of your machine. It also provides information for maintaining the toner
cartridge.

• Storing the toner cartridge
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• Tips for moving & storing your machine
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• Useful management tools
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Storing the toner cartridge
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Toner cartridges contain components that are sensitive to light,
temperature and humidity. Samsung suggests users follow these
recommendations to ensure optmal performance, highest quality,
and longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment in which the printer will
be used. This should be in controlled temperature and humidity
conditions. The toner cartridge should remain in its original and
unopened package until installation – if original packaging is not
available, cover the top opening of the cartridge with paper and
store in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its
useful shelf and operating life. Do not store on the floor. If the toner
cartridge is removed from the printer, follow the instructions below
to store the toner cartridge properly.
•

Store the cartridge inside the protective bag from the original
package.

•

Store lying flat (not standing on end) with the same side facing
up as if it were installed in the machine.

•

Do not store consumables in any of the following conditions:
-

Temperature greater than 40°C (104°F).

-

Humidity range not less than 20% and not greater than 80%.

-

An environment with extreme changes in humidity or
temperature.

-

Direct sunlight or room light.

-

Dusty places.

-

A car for a long period of time.

-

An environment where corrosive gases are present.

-

An environment with salty air.
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1

Handling instructions
•

Do not touch the surface of the photoconductive drum in the
cartridge.

•

Do not expose the cartridge to unnecessary vibrations or shock.

•

Never manually rotate the drum, especially in the reverse
direction; this can cause internal damage and toner spillage.

2

Toner cartridge usage
Samsung Electronics does not recommend or approve the use of
non-Samsung brand toner cartridges in your printer including
generic, store brand, refilled, or remanufactured toner cartridges.

Storing the toner cartridge
Samsung’s printer warranty does not cover damage to the
machine caused by the use of a refilled, remanufactured, or
non-Samsung brand toner cartridges.

3

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends
on the amount of toner that print jobs require. The actual print yield
may vary depending on the print density of the pages you print on,
operating environment, printing interval, media type and/or media
size. For example, if you print a lot of graphics, the consumption of
the toner is higher and you may need to change the cartridge more
often.
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Tips for moving & storing your machine
•

When moving the machine, do not tilt or turn it upside down.
Otherwise, the inside of the machine may be contaminated by
toner, which can cause damage to the machine or reduce print
quality.

•

When moving the machine, make sure at least two people are
holding the machine securely.
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Accessing SyncThru™ Web Service

4

Samsung AnyWeb Print
This tool helps you screen-capture, preview, scrap, and print
Windows Internet Explorer pages more easily, than when you use an
ordinary program. Click Start > All programs > Samsung Printers
> Samsung AnyWeb Print > Download the latest version to link to
the website where the tool is available for download.

1

Enter the machine IP address of your printer (http://
xxx.xxx.xxx.xxx) in the address field and press the Enter key or
click Go.

2

5

Using SyncThru™ Web Service

• Internet Explorer 6.0 or higher is the minimum
requirement for SyncThru™ Web Service.
• SyncThru™ Web Service explanation in this user’s guide
may differ from your machine depending on its options or
models.

Access a web browser, such as Internet Explorer, from
Windows.

Your machine’s embedded website opens.

► Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to
log-in as an administrator. You can still use SyncThru™ Web Service
without logging in but you won’t have access to Settings tab and
Security tab.

1

Click Login on the upper right of the SyncThru™ Web Service
website.

2

Type in the ID and Password then click Login.

• Network model only.

•

ID: admin

•

Password: sec00000

Useful management tools
SyncThru™ Web Service overview
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► Settings tab
This tab allows you to set configurations provided by your machine
and network. You need to log-in as an administrator to view this tab.

Some tabs may not appear depending on your model.

► Information tab
This tab gives you general information about your machine. You can
check things, such as remaining amount of toner. You can also print
reports, such as an error report.
•

Active Alerts: Shows the alerts that have occurred in the
machine and their severity.

•

Supplies: Shows how many pages are printed and amount of
toner left in the cartridge.

•

Usage Counters: Shows the usage count by print types: simplex
and duplex.

•

Current Settings: Shows the machine’s and network’s
information.

•

Print information: Prints reports such as system related reports
and font reports.

•

Machine Settings tab: Sets options provided by your machine.

•

Network Settings tab: Shows options for the network
environment. Sets options such as TCP/IP and network protocols.

► Security tab
This tab allows you to set system and network security information.
You need to log-in as an administrator to view this tab.
•

System Security: Sets the system administrator’s information
and also enables or disables machine features.

•

Network Security: Sets settings for HTTPs, IPSec, IPv4/IPv6
filtering, and 802.1x.

► Maintenance tab
This tab allows you to maintain your machine by upgrading firmware
and setting contact information for sending emails. You can also
connect to Samsung website or download drivers by selecting the
Link menu.
•

Firmware Upgrade: Upgrade your machine’s firmware.

•

Contact Information: Shows the contact information.

Useful management tools
•

Link: Shows links to useful sites where you can download or
check information.

E-mail notification setup
You can receive emails about your machine’s status by setting this
option. By setting information such as IP address, host name, e-mail
address and SMTP server information, the machine status (toner
cartridge shortage or machine error) will be sent to a certain person's
e-mail automatically. This option may be used more frequently by a
machine administrator.

1
2
3
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5

Select Enable check box to use the E-mail Notification.

6

Click Apply.
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Click Add button to add e-mail notification user.
Set the recipient name and e-mail address(es) with
notification items you want to receive an alert for.

If the firewall is activated, the e-mail may not be sent
successfully. In that case, contact the a network
administrator.

Start a web browser, such as Internet Explorer, from Windows.
Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the
address field and press the Enter key or click Go.

Setting the system administrator’s information

Your machine’s embedded website opens.

This setting is necessary for using the e-mail notification option.

From the Settings tab, select Machine Settings > E-mail
Notification.

If you have not configured outgoing server environment, go
to Settings > Network Settings > Outgoing Mail
Server(SMTP) to configure network environment before
setting e-mail notification.

1

Start a web browser, such as Internet Explorer, from Windows.

2
3

Your machine’s embedded website opens.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the
address field and press the Enter key or click Go.

From the Security tab, select System Security > System
Administrator

Useful management tools
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4

Enter the name of the administrator, phone number, location,
and email address.

Select Start > Programs or All Programs > Samsung Printers >
Samsung Easy Printer Manager > Samsung Easy Printer
Manager.

5

Click Apply.

The Samsung Easy Printer Manager interface is comprised of various
basic sections as described in the table that follows:

6

Using Samsung Easy Printer Manager
(Windows only)

3
1

Samsung Easy Printer Manager is a Windows-based application that
combines Samsung machine settings into one location. Samsung
Easy Printer Manager combines device settings as well as printing
environments, settings/actions and launching. All of these features
provide a gateway to conveniently use your Samsung machine.
Samsung Easy Printer Manager provides two different user
interfaces for the user to choose from: the basic user interface and
the advanced user interface. Switching between the two interfaces is
easy: just click a button.

Internet Explorer 6.0 or higher is the minimum requirement
for Samsung Easy Printer Manager.

Understanding Samsung Easy Printer Manager
To open the program:

2

4

5

6

1

Printer List

The printer list displays the installed printer icons
on your computer.

Useful management tools
Printer
Information

2

Order
6 Supplies

This area gives you general information about
your machine. You can check information, such as
the machine’s model name, IP address (or Port
name), and machine status.

User’s Guide button: This button
opens Troubleshooting Guide when
an error occurs. You can directly open
the necessary section in the user’s
guide.
Application
information

5. Maintenance

Includes links for changing to the advanced
settings, preference, help, and about.
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Click on the Order button from the supply
ordering window. You can order replacement
toner cartridge(s) from online.

Click the Help ( ) button from the upper-right corner of the
window and click on any option you want to know about.

Advanced settings user interface overview
The advanced user interface is intended to be used by the person
responsible for managing the network and machines.

► Device Settings
3

The
button is used to change the
user interface to the advanced settings
user interface.

You can configure various machine settings such as machine setup,
paper, layout, emulation, network, and print information.

► Alert Settings
Quick links
4

5

Contents
Area

Displays Quick links to machine specific
functions. This section also includes links to
applications in the advanced settings.
Displays information about the selected machine,
remaining toner level, and paper. The information
will vary based on the machine selected. Some
machines do not have this feature.

This is menu includes settings related to error alerting.
•

Printer Alert: Provides settings related to when alerts will be
received.

•

Email Alert: Povides options relating to receiving alerts via email.

•

History Alert: Provides a history of device and toner related
alerts.

Useful management tools
► Job Accounting
Provides querying of quota information of the specified job
accounting user. This quota information can be created and applied
to devices by job accounting software such as SyncThru™ or
CounThru™ admin software.

5. Maintenance
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These icons appear on the Windows task bar:
Icon

7

Mean

Description

Normal

The machine is in ready mode and experiencing
no errors or warnings.

Warning

The machine is in a state where an error might
occur in the future. For example, it might be in
toner low status, which may lead to toner empty
status.

Error

The machine has at least one error.

Using Samsung Printer Status (Windows only)
The Samsung Printer Status is a program that monitors and informs
you of the machine status.
• The Samsung Printer Status window and its contents
shown in this user’s guide may differ depending on the
machine or operating system in use.

1

• Check the operating system(s) that are compatible with
your machine (see Basic guide).
2

3

4

5

Samsung Printer Status overview
Toner Level

If an error occurs while operating, you can check the error from the
Samsung Printer Status. Samsung Printer Status is installed
automatically when you install the machine software.
You can also launch Samsung Printer Status manually. Go to the
Printing Preferences , click the Basic tab > Printer Status button.

1

You can view the level of toner remaining in
each toner cartridge. The machine and the
number of toner cartridge(s) shown in the
above window may differ depending on the
machine in use. Some machines do not have
this feature.

Useful management tools
2
3
4

Alert Settings

Select the settings you want from the options
window.

Order Supplies

You can order replacement toner cartridge(s)
from online.

Troubleshooting

You can directly open the troubleshooting
section in the user’s guide.

5 Close

Close the window.
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Smart Panel overview
If an error occurs while operating, you can check the error from the
Smart Panel. You can also launch Smart Panel manually.

Macintosh

Click this icon the Smart Panel icon on the menu
bar.

Linux

Double-click the Smart Panel icon in the
Notification Area.

8

Using Smart Panel (Macintosh and Linux only)
2

Smart Panel is a program that monitors and informs you of the
machine’s status, and allows you to customize the machine’s
settings. For Macintosh, Smart Panel is installed automatically when
you install the machine software. For Linux, you can download Smart
Panel from the Samsung website (see "Installing the Smart Panel" on
page 8).
• The Smart Panel window and its contents shown in this
user’s guide may differ depending on the machine or
operating system in use.
• Check the operating system(s) that are compatible with
your machine (see Basic Guide).

3
4
1

Toner Level

You can view the level of toner remaining in
each toner cartridge. The machine and the
number of toner cartridge(s) shown in the
above window may differ depending on the
machine in use. Some machines do not have
this feature.

Buy Now

You can order replacement toner cartridge(s)
from online.

1

2

Useful management tools
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9

User’s Guide

This button opens the
Troubleshooting Guide when an
error occurs. You can directly open
the troubleshooting section in the
user’s guide.

3

Printer Setting

4

You can view the online User’s Guide.

You can configure various machine settings in
the Printer Settings Utility window. Some
machines do not have this feature.

If you connect your machine to a
network, the SyncThru™ Web
Service window appears instead of
the Printer Settings Utility.

Using the Linux Unified Driver Configurator
The Unified Driver Configurator is a tool primarily intended for
configuring machine devices. You need to install Unified Linux
Driver to use Unified Driver Configurator (see "Installation for Linux"
on page 8).
After the driver is installed on your Linux system, the Unified Driver
Configurator icon will automatically be created on your desktop.

Opening Unified Driver Configurator

1

You can also click the Startup Menu icon and select Samsung
Unified Driver > Unified Driver Configurator.

2
Changing Smart Panel ‘s settings
Right-click in Linux or in Mac OS X click on the Smart Panel icon and
select Options. Select the settings you want from the Options
window.

Double-click the Unified Driver Configurator on the
desktop.

Click each button on the left to switch to the corresponding
configuration window.

Useful management tools
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► Printers tab
View the current system’s printer configuration by clicking on the
machine icon button on the left side of the Unified Driver
Configurator window.

1 Printer Configuration
2 Port Configuration

To use the on screen help, click Help.

3

After changing the configurations, click Exit to close the
Unified Driver Configurator.

1

Switches to Printers configuration.

2

Shows all of the installed machines.

3

Shows the status, model name, and URI of your machine.

Printers configuration
The printer control buttons are, as follows:
Printers configuration has the two tabs: Printers and Classes.

•

Refresh: Renews the available machines list.

•

Add Printer: Allows you to add a new machines.

•

Remove Printer: Removes the selected machine.

Useful management tools
•
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Set as Default: Sets the current selected machine as a default
machine.

1

Shows all of the machine classes.

•

Stop/Start: Stops/starts the machine.

2

•

Test: Allows you to print a test page to ensure the machine is
working properly.

Shows the status of the class and the number of machines in the
class.

•

Properties: Allows you to view and change the printer’s
properties.

•

Refresh: Renews the classes list.

•

Add Class: Allows you to add a new machine class.

•

Remove Class: Removes the selected machine class.

► Classes tab
The Classes tab shows a list of available machine classes.

1

Ports configuration
In this window, you can view the list of available ports, check the
status of each port and release a port that is stalled in a busy state
when its owner has terminated the job for any reason.
2

1

2

3

Useful management tools
1

Switches to Ports configuration.

2

Shows all of the available ports.

3

Shows the port type, device connected to the port, and status.

•

Refresh: Renews the available ports list.

•

Release port: Releases the selected port.
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6. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

• Paper feeding problems

105

• Power and cable connecting problems

106

• Printing problems

107

• Printing quality problems

111

• Operating system problems

119

Paper feeding problems
Condition
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Suggested solutions

Paper jams during printing.

Clear the paper jam.

Paper sticks together.

• Check the maximum paper capacity of the tray .
• Make sure that you are using the correct type of paper.
• Remove paper from the tray and flex or fan the paper.
• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.
Paper does not feed into the
machine.

• Remove any obstructions from inside the machine.
• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.
• There is too much paper in the tray. Remove excess paper from the tray.
• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming.

• There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special
materials, use the multi-purpose tray (or manual feeder).
• An incorrect type of paper is being used. Use only paper that meets the specifications required by the
machine.
• There may be debris inside the machine. Open the front cover and remove any debris.

Transparencies stick together in the Use only transparencies specifically designed for laser printers. Remove each transparency as it exits
paper exit.
from the machine.
Envelopes skew or fail to feed
correctly.

Ensure that the paper guides are against both sides of the envelopes.

Power and cable connecting problems
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Click this link to open an animation about solving power problems.

Condition

Suggested solutions

The machine is not receiving power, • Connect the machine to the electricity supply first and press the
or the connection cable between the
panel.
computer and the machine is not
• Disconnect the machine’s cable and reconnect it.
connected properly.

(Power) button on the control

Printing problems
Condition

6. Troubleshooting

Possible cause

The machine does not The machine is not receiving power.
print.
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Suggested solutions
Check the power cord connections. Check the power switch and the power
source.

The machine is not selected as the default Select your machine as your default machine in Windows.
machine.
Check the machine for the following:
• The front cover is not closed. Close the front cover.
• Paper is jammed. Clear the paper jam.
• No paper is loaded. Load paper.
• The toner cartridge is not installed. Install the toner cartridge.
If a system error occurs, contact your service representative.
The connection cable between the
computer and the machine is not
connected properly.

Disconnect the machine cable and reconnect it.

The connection cable between the
computer and the machine is defective.

If possible, attach the cable to another computer that is working properly
and print a job. You can also try using a different machine cable.

The port setting is incorrect.

Check the Windows printer settings to make sure that the print job is sent
to the correct port. If the computer has more than one port, make sure that
the machine is attached to the correct one.

The machine may be configured
incorrectly.

Check the Printing Preferences to ensure that all of the print settings are
correct.

Printing problems
Condition

Possible cause

The machine does not The printer driver may be incorrectly
print.
installed.
The machine is malfunctioning.
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Suggested solutions
Uninstall and reinstall the machine’s driver.
Check the display message on the control panel to see if the machine is
indicating a system error. Contact a service representative.

The document size is so big that the hard Get more hard disk space and print the document again.
disk space of the computer is insufficient
to access the print job.
The output tray is full.

Once the paper is removed from the output tray, the machine resumes
printing.

The machine selects
print materials from
the wrong paper
source.

The paper option that was selected in the For many software applications, the paper source selection is found under
Printing Preferences may be incorrect.
the Paper tab within the Printing Preferences. Select the correct paper
source. See the printer driver help screen.

A print job is
extremely slow.

The job may be very complex.

Half the page is blank. The page orientation setting may be
incorrect.

Reduce the complexity of the page or try adjusting the print quality
settings.
Change the page orientation in your application. See the printer driver help
screen.

The paper size and the paper size settings Ensure that the paper size in the printer driver settings matches the paper
do not match.
in the tray.
Or, ensure that the paper size in the printer driver settings matches the
paper selection in the software application settings you use.

Printing problems
Condition
The machine prints,
but the text is wrong,
garbled, or
incomplete.

Pages print, but they
are blank.

Possible cause
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Suggested solutions

The machine cable is loose or defective.

Disconnect the machine cable and reconnect. Try a print job that you have
already printed successfully. If possible, attach the cable and the machine
to another computer that you know works and try a print job. Finally, try a
new machine cable.

The wrong printer driver was selected.

Check the applicatinon’s printer selection menu to ensure that your
machine is selected.

The software application is
malfunctioning.

Try printing a job from another application.

The operating system is malfunctioning.

Exit Windows and reboot the computer. Turn the machine off and back on
again.

If you are in a DOS environment, the font
setting for your machine may be set
incorrectly.

See "Changing the font setting" on page 68.

The toner cartridge is defective or out of
toner.

Redistribute the toner, if necessary.

The file may have blank pages.

Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the
board, may be defective.

Contact a service representative.

If necessary, replace the toner cartridge.

Printing problems
Condition

Possible cause
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Suggested solutions

The machine does not Incompatibility between the PDF file and
print PDF files
the Acrobat products.
correctly. Some parts
of graphics, text, or
illustrations are
missing.

Printing the PDF file as an image may enable the file to print. Turn on Print
As Image from the Acrobat printing options.

The print quality of
photos is not good.
Images are not clear.

The resolution of the photo is very low.

Reduce the photo size. If you increase the photo size in the software
application, the resolution will be reduced.

Before printing, the
machine emits vapor
near the output tray.

Using damp paper can cause vapor during This is not a problem. Just keep printing.
printing.

It will take longer to print when you print a PDF file as an image.

The machine does not Paper size and paper size setting do not
print special-sized
match.
paper, such as billing
paper.

Set the correct paper size in the Custom in Paper tab in Printing
Preferences.

The printed billing
paper is curled.

Change the printer option and try again. Go to Printing Preferences , click
Paper tab, and set type to Thick.

The paper type setting does not match.

Printing quality problems
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If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to
clear the problem.
Condition
Light or faded print

Suggested Solutions
• If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge.
• The paper may not meet paper specifications; for example, the paper may be too moist or rough.
• If the entire page is light, the ting is too low or the toner save mode is on. Adjust the print resolution and turn
the toner save mode off. See the help screen of the printer driver.
• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the
inside of your machine.
• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine. If these steps do
not correct the problem, contact a service representative.

The top half of the paper is The toner might not adhere properly to this type of paper.
printed lighter than the
• Change the printer option and try again. Go to Printing Preferences , click the Paper tab, and set the paper
rest of the paper
type to Recycled.

Printing quality problems
Condition
Toner specks
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Suggested Solutions
• The paper may not meet specifications; for example, the paper may be too moist or rough.
• The transfer roller may be dirty. Clean the inside of your machine.

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c
Dropouts

A aBb C
A aBb C
A aBb C
A aBb C
A aBb C

• The paper path may need cleaning. Contact a service representative.

If faded areas, generally rounded, occur randomly on the page:
• A single sheet of paper may be defective. Try reprinting the job.
• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of
paper.
• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or
brand of paper.
• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick
or Thicker (see Basic Guide for paper weights for each sheet).
If these steps do not correct the problem, contact a service representative.

White Spots

If white spots appear on the page:
• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the
transfer roller may be dirty. Clean the inside of your machine.
• The paper path may need cleaning. Clean the inside of your machine.
If these steps do not correct the problem, contact a service representative.

Printing quality problems
Condition
Vertical lines
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Suggested Solutions
If black vertical streaks appear on the page:
• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the
toner cartridge and install a new one.
If white vertical streaks appear on the page:
• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine. If these steps do
not correct the problem, contact a service representative.

Black background

If the amount of background shading becomes unacceptable:
• Change to a lighter weight paper.
• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can
increase the amount of background shading.
• Remove the old toner cartridge and install a new one.

Toner smear

• Clean the inside of the machine.
• Check the paper type and quality.
• Remove the toner cartridge and install a new one.

Printing quality problems
Condition
Vertical repetitive defects
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Suggested Solutions
If marks repeatedly appear on the printed side of the page at even intervals:
• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install
a new one.
• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will
likely correct itself after a few more pages.
• The fusing assembly may be damaged. Contact a service representative.

Background scatter

A

Background scatter results from bits of toner randomly distributed on the printed page.
• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until
necessary so that the paper does not absorb too much moisture.
• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have
overlapping seams on the reverse side. Printing on seams can cause problems.
• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your
software application or in Printing Preferences. Ensure the correct paper type is selected. For example: If
Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality
problem.

Toner particles are around The toner might not adhere properly to this type of paper.
bold characters or pictures • Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type
to Recycled. Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain
Paper actually used, an overcharging can occur causing this copy quality problem.

Printing quality problems
Condition
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Suggested Solutions

Misformed characters

• If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try
different paper.

Page skew

• Ensure that the paper is loaded properly.
• Check the paper type and quality.
• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave

• Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high temperature and humidity can cause paper curl.
• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.
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Printing quality problems
Condition
Wrinkles or creases
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Suggested Solutions
• Ensure that the paper is loaded properly.
• Check the paper type and quality.
• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty

• Check for leaking toner. Clean the inside of the machine.

Solid color or black pages

• The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. Remove the toner cartridge and install a new one.

A

• The machine may require repairing. Contact a service representative.
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Printing quality problems
Condition
Loose toner
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Suggested Solutions
• Clean the inside of the machine.
• Check the paper type and quality.
• Remove the toner cartridge and then, install a new one.
If the problem persists, the machine may require repair. Contact a service representative.

Character voids

A
Horizontal stripes

Character voids are white areas within parts of characters that should be solid black:
• If you are using transparencies, try another type of transparency. Because of the composition of transparencies,
some character voids are normal.
• You may be printing on the wrong surface of the paper. Remove the paper and turn it around.
• The paper may not meet paper specifications.

If horizontally aligned black streaks or smears appear:
• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. Remove the toner cartridge and install a new one.
If the problem persists, the machine may require repairing. Contact a service representative.

Printing quality problems
Condition
Curl
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Suggested Solutions
If the printed paper is curled or paper does not feed into the machine:
• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.
• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type
to Thin.

• An unknown image
repetitively appears on
a few sheets
• Loose toner
• Light print or
contamination occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for
your machine (See "Altitude adjustment" on page 67).

Operating system problems
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1

Common Windows problems

Condition

Suggested solutions

“File in Use” message
appears during
installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the
printer driver.

“General Protection
Fault”, “Exception OE”,
“Spool 32”, or “Illegal
Operation” messages
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer
timeout error occurred”
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message
appears in ready mode or after printing has completed, check the connection and/or whether an error has
occurred.

Refer to the Microsoft Windows 2000/XP/2003/Vista User’s Guide that came with your computer for further information on Windows
error messages.

Operating system problems
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2

Common Macintosh problems

Condition
The machine does not print PDF
files correctly. Some parts of
graphics, text, or illustrations are
missing.

Suggested solutions
Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat
printing options.

It will take longer to print when you print a PDF file as an image.

The document has printed, but the Update your MAC OS to MAC OS X 10.3.3 or higher.
print job has not disappeared from
the spooler in Mac OS X10.3.2.
Some letters are not displayed
normally during cover page
printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are
displayed normally on the cover page.

When printing a document in
Macintosh with Acrobat
Reader 6.0 or higher, colors print
incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.

Refer to the Macintosh User’s Guide that came with your computer for further information on Macintosh error messages.

Operating system problems
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3

Common Linux problems

Condition
The machine does not
print.

Suggested solutions
• Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the
Printers tab in the Printers configuration window to look at the list of available machines. Make sure that
your machine is displayed on the list. If not, open Add new printer wizard to set up your device.
• Check if the machine is started. Open Printers configuration and select your machine from the printers list.
Look at the description in the Selected printer pane. If its status contains Stopped, press the Start button.
Normal operation of the machine should be restored. The “stopped” status might be activated when some
problems in printing occur.
• Check if your application has special print options such as “-oraw”. If “-oraw” is specified in the command line
parameter, then remove it to print properly. For Gimp front-end, select “print” -> “Setup printer” and edit the
command line parameter in the command item.

The machine does not
print whole pages, and
output is printed on half
the page.

It is a known problem that occurs when a color machine is used on version 8.51 or earlier of Ghostscript, 64-bit
Linux OS, and has been reported to bugs.ghostscript.com as Ghostscript Bug 688252.The problem is solved in
AFPL Ghostscript v. 8.52 or above. Download the latest version of AFPL Ghostscript from http://sourceforge.net/
projects/ghostscript/ and install it to solve this problem.

“Cannot open port device
file” error message
appears when printing a
document.

Avoid changing print job parameters (e.q., via LPR GUI) while a print job is in progress. Known versions of CUPS
server break the print job whenever print options are changed and then try to restart the job from the beginning.
Since Unified Linux Driver locks the port while printing, the abrupt termination of the driver keeps the port locked
and unavailable for subsequent print jobs. If this situation occurs, try to release the port by selecting Release port
in the Port configuration window.

Operating system problems
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Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

4

Common PostScript problems
The following situations are PS language specific and may occur when several printer languages are used.
Problem
The PostScript file cannot
be printed.

Possible cause

Solution

The PostScript driver may not be installed • Install the PostScript driver (see "Software installation" on page 4).
correctly.
• Print a configuration page and verify that the PS version is available
for printing.
• If the problem persists, contact a service representative.

Limit Check Error report
prints.

The print job was too complex.

You might need to reduce the complexity of the page or install more
memory.

A PostScript error page
prints.

The print job may not be PostScript.

Make sure that the print job is a PostScript job. Check to see whether
the software application expected a setup or PostScript header file to
be sent to the machine.

The optional tray is not
selected in the driver.

The printer driver has not been
Open the PostScript driver properties, select the Device Options tab,
configured to recognize the optional tray. and set the tray option.

Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung
products, contact the Samsung customer care center.
Country/Region

Customer Care Center

Web Site

ALBANIA

42 27 5755

ARGENTINE

0800-333-3733

ARMENIA

0-800-05-555

AUSTRALIA

1300 362 603

AUSTRIA
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AZERBAIJAN

088-55-55-555

BAHRAIN

8000-4726
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BOSNIA
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www.samsung.com

www.samsung.com

www.samsung.com
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/be (Dutch)
www.samsung.com
/be_fr (French)

05 133 1999
0800-124-421

www.samsung.com

4004-0000
07001 33 11

www.samsung.com
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Country/Region

Customer Care Center

Web Site

CANADA

1-800-SAMSUNG (726-7864) www.samsung.com

CHILE

800-SAMSUNG (726-7864)

www.samsung.com

CHINA

400-810-5858

www.samsung.com

COLOMBIA

01-8000112112

www.samsung.com

COSTA RICA

0-800-507-7267

www.samsung.com

CROATIA

062 SAMSUNG (062 726
7864)

www.samsung.com

800-SAMSUNG (800726786)

www.samsung.com

CZECH
REPUBLIC

Samsung Zrt., česká organizační složka, Oasis
Florenc, Sokolovská394/17, 180 00, Praha 8

DENMARK

70 70 19 70

www.samsung.com

DOMINICA

1-800-751-2676

www.samsung.com

ECUADOR

1-800-10-7267

www.samsung.com

EGYPT

0800-726786

www.samsung.com

EIRE

0818 717100

www.samsung.com

EL SALVADOR

800-6225

www.samsung.com

ESTONIA

800-7267

www.samsung.com

FINLAND

030-6227 515

www.samsung.com
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Country/Region

Customer Care Center

Web Site

FRANCE

01 48 63 00 00

www.samsung.com

GERMANY

01805 - SAMSUNG (7267864 € 0,14/min)

www.samsung.com

GEORGIA

GREECE
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Country/Region
INDIA

INDONESIA

8-800-555-555

Customer Care Center
3030 8282

Web Site
www.samsung.com

1800 3000 8282
0800-112-8888

www.samsung.com

021-5699-7777

IT and Mobile : 80111www.samsung.com
SAMSUNG (80111 7267864)
from land line, local charge/
from mobile, 210 6897691

IRAN

021-8255

www.samsung.com

ITALY

800-SAMSUNG (726-7864)

www.samsung.com

JAMAICA

1-800-234-7267

www.samsung.com

Cameras, Camcorders,
Televisions and Household
Appliances

JAPAN

0120-327-527

www.samsung.com

JORDAN

800-22273

www.samsung.com

KAZAKHSTAN

8-10-800-500-55-500
(GSM:7799)

www.samsung.com

From mobile and fixed
2106293100
GUATEMALA

1-800-299-0013

www.samsung.com

KOSOVO

+381 0113216899

HONDURAS

800-27919267

www.samsung.com

KUWAIT

183-2255

www.samsung.com

(852) 3698-4698

www.samsung.com
/hk

KYRGYZSTAN

00-800-500-55-500

www.samsung.com

LATVIA

8000-7267

www.samsung.com

LITHUANIA

8-800-77777

www.samsung.com

LUXEMBURG

261 03 710

www.samsung.com

MALAYSIA

1800-88-9999

www.samsung.com

HONG KONG

HUNGARY

www.samsung.com
/hk_en/
06-80-SAMSUNG (726-7864) www.samsung.com

Contact SAMSUNG worldwide
Country/Region

Customer Care Center

Web Site

MACEDONIA

023 207 777

MEXICO

01-800-SAMSUNG (7267864)

MOLDOVA

00-800-500-55-500

MONTENEGRO

020 405 888

MOROCCO

080 100 2255

www.samsung.com

NIGERIA

080-SAMSUNG(726-7864)

www.samsung.com

NETHERLANDS

0900-SAMSUNG (09007267864) (€ 0,10/min)

www.samsung.com

NEW ZEALAND

0800 SAMSUNG (0800 726
786)

www.samsung.com

NICARAGUA

00-1800-5077267

www.samsung.com

NORWAY

815-56 480

www.samsung.com

OMAN

800-SAMSUNG (726-7864)

www.samsung.com

PANAMA

800-7267

www.samsung.com

PERU

0-800-777-08

www.samsung.com
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Country/Region

Customer Care Center
1800-10-SAMSUNG (7267864)

www.samsung.com
PHILIPPINES

Web Site
www.samsung.com

1-800-3-SAMSUNG (7267864)
1-800-8-SAMSUNG (7267864)
02-5805777

POLAND

0 801 1SAMSUNG (172678)

www.samsung.com

022-607-93-33

PORTUGAL

80820-SAMSUNG (7267864)

www.samsung.com

PUERTO RICO

1-800-682-3180

www.samsung.com
www.samsung.com

RUMANIA

08010 SAMSUNG (08010
726 7864) only from
landline, local network
Romtelecom - local tariff /
021 206 01 10 for landline
and mobile, normal tariff.

RUSSIA

8-800-555-55-55

www.samsung.com

SAUDI ARABIA

9200-21230

www.samsung.com

SERBIA

0700 SAMSUNG (0700 726
7864)

www.samsung.com

Contact SAMSUNG worldwide
Country/Region

Customer Care Center

Web Site

SINGAPORE

1800-SAMSUNG (726-7864)

www.samsung.com

SLOVAKIA

0800-SAMSUNG (726-7864)

www.samsung.com

SOUTH AFRICA

0860 SAMSUNG (726-7864)

www.samsung.com

SPAIN

902-1-SAMSUNG(902 172
678)

www.samsung.com

SWEDEN

0771 726 7864 (SAMSUNG)

www.samsung.com

SWITZERLAND

0848-SAMSUNG (7267864,
CHF 0.08/min)

www.samsung.com
/ch
www.samsung.com
/ch_fr/

TADJIKISTAN

8-10-800-500-55-500

www.samsung.com

TAIWAN

0800-329-999

www.samsung.com

1800-29-3232

www.samsung.com

THAILAND

02-689-3232

TRINIDAD &
TOBAGO

1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY

444 77 11

www.samsung.com

U.A.E

800-SAMSUNG (726-7864)

www.samsung.com

U.K

0330 SAMSUNG (726-7864)

www.samsung.com
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Country/Region
U.S.A

Customer Care Center

Web Site

1-800-SAMSUNG (726-7864) www.samsung.com
0-800-502-000

UKRAINE

www.samsung.com
/ua
www.samsung.com
/ua_ru

UZBEKISTAN

8-10-800-500-55-500

www.samsung.com

VENEZUELA

0-800-100-5303

www.samsung.com

VIETNAM

1 800 588 889

www.samsung.com
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ADF
The following glossary helps you get familiar with the
product by understanding the terminologies commonly
used with printing as well as mentioned in this user’s guide.

An Automatic Document Feeder (ADF) is a scanning unit that will
automatically feed an original sheet of paper so that the machine
can scan some amount of the paper at once.

802.11

AppleTalk

802.11 is a set of standards for wireless local area network (WLAN)
communication, developed by the IEEE LAN/MAN Standards
Committee (IEEE 802).

AppleTalk is a proprietary suite of protocols developed by Apple, Inc
for computer networking. It was included in the original Macintosh
(1984) and is now deprecated by Apple in favor of TCP/IP
networking.

802.11b/g/n
802.11b/g/n can share same hardware and use the 2.4 GHz band.
802.11b supports bandwidth up to 11 Mbps, 802.11n supports
bandwidth up to 150 Mbps. 802.11b/g/n devices may occasionally
suffer interference from microwave ovens, cordless telephones, and
Bluetooth devices.

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that
connects wireless communication devices together on wireless local
area networks (WLAN), and acts as a central transmitter and receiver
of WLAN radio signals.

BIT Depth
A computer graphics term describing the number of bits used to
represent the color of a single pixel in a bitmapped image. Higher
color depth gives a broader range of distinct colors. As the number
of bits increases, the number of possible colors becomes
impractically large for a color map. 1-bit color is commonly called as
monochrome or black and white.

BMP
A bitmapped graphics format used internally by the Microsoft
Windows graphics subsystem (GDI), and used commonly as a simple
graphics file format on that platform.
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BOOTP

Coverage

Bootstrap Protocol. A network protocol used by a network client to
obtain its IP address automatically. This is usually done in the
bootstrap process of computers or operating systems running on
them. The BOOTP servers assign the IP address from a pool of
addresses to each client. BOOTP enables 'diskless workstation'
computers to obtain an IP address prior to loading any advanced
operating system.

It is the printing term used for a toner usage measurement on
printing. For example, 5% coverage means that an A4 sided paper
has about 5% image or text on it. So, if the paper or original has
complicated images or lots of text on it, the coverage will be higher
and at the same time, a toner usage will be as much as the coverage.

CCD

Comma Separated Values (CSV). A type of file format, CSV is used to
exchange data between disparate applications. The file format, as it
is used in Microsoft Excel, has become a de facto standard
throughout the industry, even among non-Microsoft platforms.

Charge Coupled Device (CCD) is a hardware which enables the scan
job. CCD Locking mechanism is also used to hold the CCD module to
prevent any damage when you move the machine.

CSV

DADF
Collation
Collation is a process of printing a multiple-copy job in sets. When
collation is selected, the device prints an entire set before printing
additional copies.

A Duplex Automatic Document Feeder (DADF) is a scanning unit that
will automatically feed and turn over an original sheet of paper so
that the machine can scan on both sides of the paper.

Default
Control Panel
A control panel is a flat, typically vertical, area where control or
monitoring instruments are displayed. They are typically found in
front of the machine.

The value or setting that is in effect when taking a printer out of its
box state, reset, or initialized.
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DHCP

Dot Matrix Printer

A Dynamic Host Configuration Protocol (DHCP) is a client-server
networking protocol. A DHCP server provides configuration
parameters specific to the DHCP client host requesting, generally,
information required by the client host to participate on an IP
network. DHCP also provides a mechanism for allocation of IP
addresses to client hosts.

A dot matrix printer refers to a type of computer printer with a print
head that runs back and forth on the page and prints by impact,
striking an ink-soaked cloth ribbon against the paper, much like a
typewriter.

DIMM

Dots Per Inch (DPI) is a measurement of resolution that is used for
scanning and printing. Generally, higher DPI results in a higher
resolution, more visible detail in the image, and a larger file size.

Dual Inline Memory Module (DIMM), a small circuit board that holds
memory. DIMM stores all the data within the machine like printing
data, received fax data.

DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows
devices on a home network to share information with each other
across the network.

DNS
The Domain Name Server (DNS) is a system that stores information
associated with domain names in a distributed database on
networks, such as the Internet.

DPI

DRPD
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone
company service which enables a user to use a single telephone line
to answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so
that the machine can print (or scan) on both sides of the paper. A
printer equipped with a Duplex Unit can print on both sides of paper
during one print cycle.
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Duty Cycle

Ethernet

Duty cycle is the page quantity which does not affect printer
performance for a month. Generally the printer has the lifespan
limitation such as pages per year. The lifespan means the average
capacity of print-outs, usually within the warranty period. For
example, if the duty cycle is 48,000 pages per month assuming 20
working days, a printer limits 2,400 pages a day.

Ethernet is a frame-based computer networking technology for local
area networks (LANs). It defines wiring and signaling for the physical
layer, and frame formats and protocols for the media access control
(MAC)/data link layer of the OSI model. Ethernet is mostly
standardized as IEEE 802.3. It has become the most widespread LAN
technology in use during the 1990s to the present.

ECM

EtherTalk

Error Correction Mode (ECM) is an optional transmission mode built
into Class 1 fax machines or fax modems. It automatically detects
and corrects errors in the fax transmission process that are
sometimes caused by telephone line noise.

A suite of protocols developed by Apple Computer for computer
networking. It was included in the original Macintosh (1984) and is
now deprecated by Apple in favor of TCP/IP networking.

FDI
Emulation
Emulation is a technique of one machine obtaining the same results
as another.
An emulator duplicates the functions of one system with a different
system, so that the second system behaves like the first system.
Emulation focuses on exact reproduction of external behavior,
which is in contrast to simulation, which concerns an abstract model
of the system being simulated, often considering its internal state.

Foreign Device Interface (FDI) is a card installed inside the machine
to allow a third party device such as a coin operated device or a card
reader. Those devices allow the pay-for-print service on your
machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for
exchanging files over any network that supports the TCP/IP protocol
(such as the Internet or an intranet).
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Fuser Unit

HDD

The part of a laser printer that fuses the toner onto the print media.
It consists of a heat roller and a pressure roller. After toner is
transferred onto the paper, the fuser unit applies heat and pressure
to ensure that the toner stays on the paper permanently, which is
why paper is warm when it comes out of a laser printer.

Hard Disk Drive (HDD), commonly referred to as a hard drive or hard
disk, is a non-volatile storage device which stores digitally-encoded
data on rapidly rotating platters with magnetic surfaces.

Gateway

The Institute of Electrical and Electronics Engineers (IEEE) is an
international non-profit, professional organization for the
advancement of technology related to electricity.

A connection between computer networks, or between a computer
network and a telephone line. It is very popular, as it is a computer or
a network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image
when color images are converted to grayscale; colors are
represented by various shades of gray.

IEEE

IEEE 1284
The 1284 parallel port standard was developed by the Institute of
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers
to a specific connector type on the end of the parallel cable that
attaches to the peripheral (for example, a printer).

Intranet
Halftone
An image type that simulates grayscale by varying the number of
dots. Highly colored areas consist of a large number of dots, while
lighter areas consist of a smaller number of dots.

A private network that uses Internet Protocols, network connectivity,
and possibly the public telecommunication system to securely share
part of an organization's information or operations with its
employees. Sometimes the term refers only to the most visible
service, the internal website.
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IP address

IPX/SPX

An Internet Protocol (IP) address is a unique number that devices use
in order to identify and communicate with each other on a network
utilizing the Internet Protocol standard.

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet
Exchange. It is a networking protocol used by the Novell NetWare
operating systems. IPX and SPX both provide connection services
similar to TCP/IP, with the IPX protocol having similarities to IP, and
SPX having similarities to TCP. IPX/SPX was primarily designed for
local area networks (LANs), and is a very efficient protocol for this
purpose (typically its performance exceeds that of TCP/IP on a LAN).

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a
printer. An IPM rate indicates the number of single-sided sheets a
printer can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for
printing as well as managing print jobs, media size, resolution, and
so forth. IPP can be used locally or over the Internet to hundreds of
printers, and also supports access control, authentication, and
encryption, making it a much more capable and secure printing
solution than older ones.

ISO
The International Organization for Standardization (ISO) is an
international standard-setting body composed of representatives
from national standards bodies. It produces world-wide industrial
and commercial standards.

ITU-T
The International Telecommunication Union is an international
organization established to standardize and regulate international
radio and telecommunications. Its main tasks include
standardization, allocation of the radio spectrum, and organizing
interconnection arrangements between different countries to allow
international phone calls. A -T out of ITU-T indicates
telecommunication.
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ITU-T No. 1 chart

LED

Standardized test chart published by ITU-T for document facsimile
transmissions.

A Light-Emitting Diode (LED) is a semiconductor device that
indicates the status of a machine.

JBIG

MAC address

Joint Bi-level Image Experts Group (JBIG) is an image compression
standard with no loss of accuracy or quality, which was designed for
compression of binary images, particularly for faxes, but can also be
used on other images.

Media Access Control (MAC) address is a unique identifier associated
with a network adapter. MAC address is a unique 48-bit identifier
usually written as 12 hexadecimal characters grouped in pairs (e. g.,
00-00-0c-34-11-4e). This address is usually hard-coded into a
Network Interface Card (NIC) by its manufacturer, and used as an aid
for routers trying to locate machines on large networks.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used
standard method of lossy compression for photographic images. It is
the format used for storing and transmitting photographs on the
World Wide Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking
protocol for querying and modifying directory services running over
TCP/IP.

MFP
Multi Function Peripheral (MFP) is an office machine that includes
the following functionality in one physical body, so as to have a
printer, a copier, a fax, a scanner and etc.

Glossary

134

MH

NetWare

Modified Huffman (MH) is a compression method for decreasing the
amount of data that needs to be transmitted between the fax
machines to transfer the image recommended by ITU-T T.4. MH is a
codebook-based run-length encoding scheme optimized to
efficiently compress white space. As most faxes consist mostly of
white space, this minimizes the transmission time of most faxes.

A network operating system developed by Novell, Inc. It initially used
cooperative multitasking to run various services on a PC, and the
network protocols were based on the archetypal Xerox XNS stack.
Today NetWare supports TCP/IP as well as IPX/SPX.

MMR

Organic Photo Conductor (OPC) is a mechanism that makes a virtual
image for print using a laser beam emitted from a laser printer, and
it is usually green or rust colored and has a cylinder shape.

Modified Modified READ (MMR) is a compression method
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital
information, and also demodulates such a carrier signal to decode
transmitted information.

MR
Modified Read (MR) is a compression method recommended by ITUT T.4. MR encodes the first scanned line using MH. The next line is
compared to the first, the differences determined, and then the
differences are encoded and transmitted.

OPC

An imaging unit containing a drum slowly wears the drum surface by
its usage in the printer, and it should be replaced appropriately since
it gets worn from contact with the cartridge development brush,
cleaning mechanism, and paper.

Originals
The first example of something, such as a document, photograph or
text, etc, which is copied, reproduced or translated to produce
others, but which is not itself copied or derived from something else.
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OSI

PDF

Open Systems Interconnection (OSI) is a model developed by the
International Organization for Standardization (ISO) for
communications. OSI offers a standard, modular approach to
network design that divides the required set of complex functions
into manageable, self-contained, functional layers. The layers are,
from top to bottom, Application, Presentation, Session, Transport,
Network, Data Link and Physical.

Portable Document Format (PDF) is a proprietary file format
developed by Adobe Systems for representing two dimensional
documents in a device independent and resolution independent
format.

PABX
A private automatic branch exchange (PABX) is an automatic
telephone switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language
(PDL) developed by HP as a printer protocol and has become an
industry standard. Originally developed for early inkjet printers, PCL
has been released in varying levels for thermal, dot matrix printer,
and laser printers.

PostScript
PostScript (PS) is a page description language and programming
language used primarily in the electronic and desktop publishing
areas. - that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the
computer to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which
can be used in a printer, a scanner, a fax or, a copier.
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PPM

PSTN

Pages Per Minute (PPM) is a method of measurement for
determining how fast a printer works, meaning the number of pages
a printer can produce in one minute.

The Public-Switched Telephone Network (PSTN) is the network of
the world's public circuit-switched telephone networks which, on
industrial premises, is usually routed through the switchboard.

PRN file

RADIUS

An interface for a device driver, this allows software to interact with
the device driver using standard input/output system calls, which
simplifies many tasks.

Remote Authentication Dial In User Service (RADIUS) is a protocol for
remote user authentication and accounting. RADIUS enables
centralized management of authentication data such as usernames
and passwords using an AAA (authentication, authorization, and
accounting) concept to manage network access.

Protocol
A convention or standard that controls or enables the connection,
communication, and data transfer between two computing
endpoints.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The
higher the dpi, the greater the resolution.

PS
SMB
See PostScript.
Server Message Block (SMB) is a network protocol mainly applied to
share files, printers, serial ports, and miscellaneous communications
between nodes on a network. It also provides an authenticated Interprocess communication mechanism.

Glossary

137

SMTP

TCP/IP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail
transmissions across the Internet. SMTP is a relatively simple, textbased protocol, where one or more recipients of a message are
specified, and then the message text is transferred. It is a clientserver protocol, where the client transmits an email message to the
server.

The Transmission Control Protocol (TCP) and the Internet Protocol
(IP); the set of communications protocols that implement the
protocol stack on which the Internet and most commercial networks
run.

SSID

Transmission Confirmation Report (TCR) provides details of each
transmission such as job status, transmission result and number of
pages sent. This report can be set to print after each job or only after
failed transmissions.

Service Set Identifier (SSID) is a name of a wireless local area network
(WLAN). All wireless devices in a WLAN use the same SSID in order to
communicate with each other. The SSIDs are case-sensitive and have
a maximum length of 32 characters.

Subnet Mask
The subnet mask is used in conjunction with the network address to
determine which part of the address is the network address and
which part is the host address.

TCR

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped
image format. TIFF describes image data that typically come from
scanners. TIFF images make use of tags, keywords defining the
characteristics of the image that is included in the file. This flexible
and platform-independent format can be used for pictures that have
been made by various image processing applications.
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Toner Cartridge

URL

A kind of bottle or container used in a machine like a printer which
contains toner. Toner is a powder used in laser printers and
photocopiers, which forms the text and images on the printed paper.
Toner can be fused by by a combination of heat/pressure from the
fuser, causing it to bind to the fibers in the paper.

Uniform Resource Locator (URL) is the global address of documents
and resources on the Internet. The first part of the address indicates
what protocol to use, the second part specifies the IP address or the
domain name where the resource is located.

USB
TWAIN
An industry standard for scanners and software. By using a TWAINcompliant scanner with a TWAIN-compliant program, a scan can be
initiated from within the program. It is an image capture API for
Microsoft Windows and Apple Macintosh operating systems.

Universal Serial Bus (USB) is a standard that was developed by the
USB Implementers Forum, Inc., to connect computers and
peripherals. Unlike the parallel port, USB is designed to concurrently
connect a single computer USB port to multiple peripherals.

Watermark
UNC Path
Uniform Naming Convention (UNC) is a standard way to access
network shares in Window NT and other Microsoft products. The
format of a UNC path is: \\<servername>\<sharename>\<Additional
directory>

A watermark is a recognizable image or pattern in paper that
appears lighter when viewed by transmitted light. Watermarks were
first introduced in Bologna, Italy in 1282; they have been used by
papermakers to identify their product, and also on postage stamps,
currency, and other government documents to discourage
counterfeiting.
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WEP

WPS

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE
802.11 to provide the same level of security as that of a wired LAN.
WEP provides security by encrypting data over radio so that it is
protected as it is transmitted from one end point to another.

The Wi-Fi Protected Setup (WPS) is a standard for establishing a
wireless home network. If your wireless access point supports WPS,
you can configure the wireless network connection easily without a
computer.

WIA

XPS

Windows Imaging Architecture (WIA) is an imaging architecture that
is originally introduced in Windows Me and Windows XP. A scan can
be initiated from within these operating systems by using a WIAcompliant scanner.

XML Paper Specification (XPS) is a specification for a Page
Description Language (PDL) and a new document format, which has
benefits for portable document and electronic document,
developed by Microsoft. It is an XML-based specification, based on a
new print path and a vector-based device-independent document
format.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless
(Wi-Fi) computer networks, which was created to improve upon the
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small
business or home users. A shared key, or password, is configured in
the wireless access point (WAP) and any wireless laptop or desktop
devices. WPA-PSK generates a unique key for each session between
a wireless client and the associated WAP for more advanced security.
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L

printing

83

LCD display

using SetIP
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browsing the machine status
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Linux
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8
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Macintosh
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printing
changing the default print settings

69

Linux
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Macintosh

83

multiple pages on one sheet of paper
Macintosh
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W

service contact numbers
SetIP program
special print features

84

printing to a file
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using direct printing utility
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using SetIP

13, 49

wireless

toner cartridge

printing a document

Windows
common Windows problems
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Macintosh
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ad hoc mode
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Linux
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computer
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Macintosh
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handling instructions
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control panel
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non-Samsung and refilled
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Infrastructure mode
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storing
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installation
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USB cable
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WPS
disconnectiong
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problems
paper feeding problems
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